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1 About this manual
Welcome to the IBM® Rational® DOORS® product family, a powerful set of 
tools that help you capture, track, and manage your user requirements.
This document contains information about installing and setting up your 
Rational DOORS products.

These documents are on the Rational Information Center at http://
publib.boulder.ibm.com/infocenter/rsdp/v1r0m0/index.jsp.

For information about See

What is new in Rational DOORS The Rational DOORS readme file

How to set up licenses to use Rational 
DOORS

Rational License Server TL Licensing Guide

How to use Rational DOORS Getting Started with Rational DOORS
Using Rational DOORS

How to use the Rational DOORS 
integrations

Using Rational DOORS for ClearCase 
Interface
Using Rational DOORS for ClearQuest 
Interface
Using Rational DOORS for HP Quality 
Center Interface
Using Rational DOORS for Rational Rose 
Interface
Using Rational DOORS for Serena PVCS 
Version Manager Interface

How to set up and manage Rational 
DOORS

Managing Rational DOORS

How to write requirements Get It Right the First Time

The DXL programming language DXL Reference Manual

How to integrate Rational DOORS with 
other applications

Rational DOORS API Manual
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2 Introduction
• What is Rational DOORS?

• What types of Rational DOORS installation can I have?

• What are the licensing options?

• What next?

What is Rational DOORS?
The Rational DOORS product family is a package of requirements management 
tools designed to help enterprises effectively manage projects from the concepts 
phase right through to completion.
The products in the Rational DOORS family allow everyone in your 
organization to participate in and contribute to the requirements management 
process.

Product name Description

IBM Rational DOORS At the heart of the family is Rational DOORS, an 
application that runs on Windows® and UNIX® systems. 
With its own built-in database, Rational DOORS provides 
a rich set of features to help you capture and manage 
requirements.

IBM Rational DOORS 
Web Access

Rational DOORS Web Access is a web client that allows 
you to access modules in your Rational DOORS database.
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IBM® Rational® 
DOORS® Analyst Add 
On

Rational DOORS Analyst Add On is a modeling 
environment available inside Rational DOORS. Rational 
DOORS Analyst Add On enables users to augment and 
visualize requirements using diagrams, symbols, and 
pictures based on the standardized, visual modeling 
language UML 2.0, which are embedded directly within 
your Rational DOORS modules.
Rational DOORS Analyst Add On is a natural extension 
to the rich capabilities already available in Rational 
DOORS. With its powerful, yet easy-to-learn visual 
modeling features, Rational DOORS Analyst Add On 
provides complete freedom of expression when defining 
requirements. With Rational DOORS Analyst Add On 
you can easily augment your requirements descriptions 
with pictures, diagrams and models, to give extra life to 
and simplify understanding of requirements.

IBM® Rational® 
DOORS® for 
ClearCase® Interface

Rational DOORS for ClearCase Interface is one of the 
Rational DOORS integration products. It lets you transfer 
data between Rational DOORS and ClearCase®, so you 
can synchronize configuration management regimes and 
establish traceability between information managed in 
Rational DOORS and versions managed by ClearCase.

IBM® Rational® 
DOORS® for 
ClearQuest® Interface

Rational DOORS for ClearQuest Interface is one of the 
Rational DOORS integration products. It lets you transfer 
data between Rational DOORS and ClearQuest®. The 
integration tracks a CR through its entire lifecycle 
providing status information about Rational DOORS 
artifacts impacted by their implementation such as 
requirements and tests

IBM® Rational® 
DOORS® for HP 
Quality Center 
Interface

Rational DOORS for HP Quality Center Interface is one 
of the Rational DOORS integration products. It lets you 
transfer data between Rational DOORS and Quality 
Center, and allows you to add traceability to the testing 
process.

Product name Description
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What types of Rational DOORS installation can I have?

What types of Rational DOORS installation can I have?
There are three types of Rational DOORS installations:

IBM® Rational® 
DOORS® for Rational 
Quality Manager® 
Interface

Rational DOORS for Rational Quality Manager Interface 
is one of the Rational DOORS integration products. It lets 
you transfer data between Rational DOORS and Rational 
Quality Manager®, so you can add traceability to the 
testing process.

IBM® Rational® 
DOORS® for Rational 
Rose® Interface

Rational DOORS for Rational Rose Interface is one of the 
Rational DOORS integration products. It lets you transfer 
data between Rational DOORS and Rational Rose®, so 
you can add traceability to your software design process.

IBM® Rational® 
DOORS® for Serena 
PVCS Version Manager 
Interface

Rational DOORS for Serena PVCS Version Manager 
Interface is one of the Rational DOORS integration 
products. It lets you transfer data between Rational 
DOORS and Serena PVCS Version Manager. It allows 
complete life cycle traceability from requirements through 
to configuration management.

Setup type Description

Rational DOORS 
Client

Installs Rational DOORS client application files on a local 
machine. The client can either access a database on the 
local machine, or on a networked machine.
In the course of the installation, you can choose to install 
the Rational DOORS for Rational Quality Manager 
Interface.
You can set up licensing for local or remote access.

Rational DOORS 
Server

Installs the Rational DOORS database server on a local 
machine.
In the course of the installation, you can choose to install 
the Rational DOORS server interface services.
You can set up licensing for local or remote access.

Product name Description
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What are the licensing options?
You must have either a software or hardware license to run any of the Rational 
DOORS products.
Unless you are running Rational DOORS 8.2 or Rational DOORS 8.3, and have 
a valid maintenance agreement, you must request a new software license for 
Rational DOORS 9.2. Software licenses for all versions of Rational DOORS 8.1 
and earlier are not compatible with Rational DOORS 9.2.
Rainbow dongles are no longer supported by Rational DOORS. Customers who 
have previously used Rainbow dongles to run Rational DOORS must contact 
their local Support department. Other existing hardware licenses do not need to 
be replaced.
For more information about licensing, see the Rational License Server TL Licensing 
Guide, which is available from the Rational Lifecycle Solutions DVD, and from 
our Web site at http://www.ibm.com/software/awdtools/doors/support/
doc.html.

What next?
The following table describes the different Rational DOORS installation options 
that are covered in this manual.

Rational DOORS 
Example Data

Installs the Rational DOORS example database on a local 
machine.
Users can familiarize themselves with Rational DOORS 
without accessing production data or installing a local 
Rational DOORS database server.

If you are installing Rational DOORS 
9.2 on

Go to

A Windows machine that does not have 
a previous version of Rational DOORS 
installed

“New installation of Rational DOORS 
on Windows,” on page 9

A Windows machine that is currently 
running a version 5,6,7 or 8 of Rational 
DOORS

“Upgrading from version 5, 6, 7 or 8,” 
on page 27

Setup type Description
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What next?

A Windows machine that is currently 
running 9.0 or 9.1 of Rational DOORS

“Upgrading from version 9.0 and later,” 
on page 23

A UNIX machine “Installing the Rational DOORS server 
on UNIX,” on page 37

A Citrix machine “Installing and using Rational DOORS 
on Citrix,” on page 35

If you are installing Rational DOORS 
9.2 on

Go to
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3 New installation of Rational DOORS on 
Windows

This chapter describes how to install and set up Rational DOORS 9.2 on a 
machine that does not have a previous version of Rational DOORS installed. If 
you want to upgrade your current version of Rational DOORS, follow the 
instructions in either “Upgrading from version 9.0 and later,” on page 23 or 
“Upgrading from version 5, 6, 7 or 8,” on page 27.
This chapter contains the following:

• Installing the Rational DOORS database server

• Installing the Rational DOORS client

• Installing Rational DOORS for Rational Quality Manager Interface

• Silent installation

• Starting Rational DOORS

• RDS, the Rational DOORS database and UUIDs

• Installing the Rational DOORS Example Data

• Uninstalling Rational DOORS

Installing the Rational DOORS database server
Follow these steps to install the Rational DOORS database server.

Note  If you are installing both the Rational DOORS client and the 
Rational DOORS database server on the same machine, 
install the Rational DOORS client first. The Rational 
DOORS database server and the Rational DOORS client 
share components. If you install the server before the client, 
you might need to restart your machine during the client 
installation. For information about the client installation, see 
“Installing the Rational DOORS client,” on page 12. When 
you have installed the Rational DOORS client, follow the 
steps to install the Rational DOORS database server.

1. Check that you meet the system requirements. Details of system 
requirements are on our Web site at http://www-01.ibm.com/software/
awdtools/doors/sysreqs/.
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2. Make sure the IBM® Rational® License Server TL is installed on your 
system. For information about installing the Rational License Server TL, see 
the Rational License Server TL Licensing Guide, which is available from the 
Rational Lifecycle Solutions DVD, and from our Web site at http://
publib.boulder.ibm.com/infocenter/rsdp/v1r0m0/index.jsp.

3. Make sure that you are logged on to your computer as the local 
Administrator, and not a user with Administrator privileges.

4. Shut down all other applications. In particular, shut down Microsoft® 
Office applications, including the Microsoft Office toolbar.

5. You can either install from the Rational Solutions DVD or from Rational 
DOORS software downloaded from the Rational Web site.

If you are installing from DVD, put the Rational Lifecycle Solutions DVD 
into your DVD-ROM drive, browse to the Rational DOORS server software 
and click to install. The Rational DOORS database server installer runs, and 
the Welcome screen is displayed.

If you downloaded the Rational DOORS database server software from the 
Web site, navigate to the file you downloaded, and double-click it. The 
Rational DOORS database server installer runs, and the Welcome screen is 
displayed.

6. Click Next.
The License Agreement screen is displayed.

7. If you accept the terms of the license agreement, select the I accept... 
option and click Next.
If you do not have a Rational DOORS client installed on your machine, the 
Destination Folder screen is displayed. If you have a Rational DOORS 
client installed, the Setup Type screen is displayed. Go to step 9.

8. Enter the path to the folder you want to use for your Rational DOORS 
installation, or leave the default.

If you want to change the directory:

a. Click the Change button.

b. Browse to the directory you want to install to.

c. Click OK.

The Setup Type screen is displayed.

9. Select either the Custom setup type or the Typical setup type, and click 
Next.
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Installing the Rational DOORS database server

The Custom setup type installs the Rational DOORS database server and 
the Rational DOORS server interface services. These allow Rational 
DOORS to interface with selected other products, for example Rational 
Requirements Composer. For information about using the Custom setup 
type to install, see “Installing the Rational DOORS server interface services 
on Windows,” on page 41.

Note  This method of integrating with other products is not 
used for integrations like Rational DOORS for 
ClearCase Interface, Rational DOORS for ClearQuest 
Interface, and so on. For information about installing 
these integrations, see the appropriate chapter in this 
guide.

The Typical setup type installs the Rational DOORS database server.

The DOORS Database Server Settings screen is displayed.

10. Enter the Port Number and the Data Directory.

a. In Port Number, type the port number to be used by your Rational 
DOORS database server. Do not use a number lower than 1000. The 
default port used by Rational DOORS is 36677.

b. In Data Directory, type the path to the directory you want to use for 
your Rational DOORS database. This directory must be on the local 
machine and is where your data and user information are stored. 
Rational DOORS does not support mapped drives for data.

c. Click Next.
Note  If the port you specified is already being used by another 

application, a message is displayed. Click OK, type a 
different port number and click Next.

The Ready to Install the Program screen is displayed.

The settings you defined in the previous steps are displayed. Use the Back 
button if you want to change any of your settings.

11. Click Install.
12. When all the files are installed, the Finish screen is displayed. Click Finish 

to complete the installation.
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Installing the Rational DOORS client
If you are installing both the Rational DOORS client and the Rational DOORS 
database server on the same machine, install the Rational DOORS client first.

1. Ensure that you have a Rational DOORS 9.2 license. For more information 
about licensing, see the Rational License Server TL Licensing Guide, which is 
available from the Rational Lifecycle Solutions DVD, and from our Web 
site at http://publib.boulder.ibm.com/infocenter/rsdp/v1r0m0/index.jsp.

2. Check that you meet the system requirements. Details of system 
requirements are on our Web site at http://www-01.ibm.com/software/
awdtools/doors/sysreqs/.

3. Make sure the Rational License Server TL is installed on your system. For 
information about installing the Rational License Server TL, see the Rational 
License Server TL Licensing Guide.

4. Make sure that you are logged on to your computer as the local 
Administrator, and not a user with Administrator privileges.

If you cannot log on to your computer as the local Administrator, see 
“Installing Rational DOORS as a non-admin user,” on page 99.

5. Shut down all other applications. In particular, shut down Microsoft Office 
applications, including the Microsoft Office toolbar.

6. You can either install from the Rational Solutions DVD or from Rational 
DOORS software downloaded from the Rational Web site.

If you are installing from DVD:

a. Put the Rational Lifecycle Solutions DVD into your DVD-ROM 
drive, browse to Rational Lifecycle Solutions Clients, and click to 
install.

The Rational Lifecycle Solutions Setup runs, and the Welcome 
screen is displayed. 

b. Click Next.
The License Agreement screen is displayed.

c. If you accept the terms of the license agreement, select the I accept... 
option and click Next.
The Select Products screen is displayed.

d. If you only want to install Rational DOORS, clear all the other options 
and click Next. Go to step 9.
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Installing the Rational DOORS client

For information about installing products other than Rational DOORS, 
see the appropriate installation manual, which is available from the 
Rational Lifecycle Solutions DVD.

If you downloaded the Rational DOORS client software from the Web site, 
navigate to the file you downloaded, and double-click it.

The Welcome screen is displayed.

7. Click Next.
The License Agreement screen is displayed.

8. If you accept the terms of the license agreement, select the I accept... 
option and click Next.

9. The Destination Folder screen is displayed. 

Enter the path to the folder you want to use for your Rational DOORS 
installation, or leave the default.

The default installation folder is 
C:\Program Files\IBM\Rational\DOORS\9.2.

If you want to change the directory:

a. Click the Change button.

b. Browse to the directory you want to install to.

c. Click OK.

10. Click Next.
The Setup Type screen is displayed.

11. Select either the Custom setup type or the Typical setup type.

The Custom setup type installs the Rational DOORS client, the Rational 
DOORS for Rational Quality Manager Interface client, and the Rational 
DOORS for Rational Quality Manager Interface server. For information 
about using the Custom setup type, see “Installing Rational DOORS for 
Rational Quality Manager Interface,” on page 14.

The Typical setup type installs the Rational DOORS client.

12. Click Next.
The DOORS Database Settings screen is displayed.

13. Type the port number the Rational DOORS database server is using in the 
Database Port field, and the name of the Rational DOORS database server 
machine in the Database Host field.
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14. Click Next.
The License Information screen is displayed.

15. If you do not have details of your license, select Supply license 
information later.
If you know the location of your Rational DOORS license, type the 
information in the appropriate field.

• License Server

If you are using a floating license, enter the location of the license server 
in the form port@host, for example 19353@licenseserver.

• Local License File

If you have a node-locked license, copy it to a folder on your machine 
and type the path to the file.

Note  If you are installing as a non-admin user you must supply 
license information about this screen.

16. Click Next.
The Ready to Install the Program screen is displayed. 

The settings you defined in the previous steps are displayed. Use the Back 
button if you want to change any of your settings.

If you want to create a desktop shortcut, select the check box.

17. Click Install.
18. When all the files are copied, the Finish screen is displayed. 

Installing Rational DOORS for Rational Quality Manager Interface
Rational DOORS for Rational Quality Manager Interface is installed using the 
Custom Setup screen, which is part of the Rational DOORS client installation. 
You can use the Custom Setup screen to install the Rational DOORS client, 
and the Rational DOORS for Rational Quality Manager Interface.
To install the Rational DOORS client, follow the steps in “Installing the Rational 
DOORS client,” on page 12. The procedure is the same, whether you install the 
Rational DOORS client using the Typical setup type or the Custom setup type.
Rational DOORS for Rational Quality Manager Interface is made up of two 
separate components:

• The Rational DOORS for Rational Quality Manager Interface client
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Installing Rational DOORS for Rational Quality Manager Interface

• The Rational DOORS for Rational Quality Manager Interface server

You can install one or other of the components or both. When you make your 
selection, click Next on the Custom Setup screen, and your choice is installed 
along with the Rational DOORS client.

Caution  If you are upgrading your version of Rational DOORS for 
Rational Quality Manager Interface, you must enter exactly 
the same details that you entered for the previous version. 
For example, you must enter the same details in the 
RQMI Server Port Number field as were entered when 
the previous version of the software was installed.

The Rational DOORS for Rational Quality Manager Interface client
To install the Rational DOORS for Rational Quality Manager Interface 
client:
1. Follow step 1 to step 10 in “Installing the Rational DOORS client,” on page 

12.

2. On the The Setup Type screen select the Custom setup type.

The Custom Setup screen is displayed.

3. Select DOORS Rational Quality Manager Interface, and click Next.
The DOORS Database Server Settings screen is displayed.

4. Type the port number the Rational DOORS database server is using in the 
Database Port field, and the name of the Rational DOORS database server 
machine in the Database Host field, and then click Next.
The Rational Quality Manager Interface screen is displayed.

5. Enter the Rational Quality Manager Server details:

6. Click Next.
The License Information screen is displayed.

Field name Details

RQMI Server Port Number Type the port number the Rational 
DOORS for Rational Quality 
Manager Interface server.

RQM Server Type the name of the Rational 
Quality Manager server machine.
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7. If you do not have details of your license, select Supply license 
information later.
If you know the location of your Rational DOORS license, type the 
information in the appropriate field.

• License Server

If you are using a floating license, enter the location of the license server 
in the form port@host, for example 19353@licenseserver.

• Local License File

If you have a node-locked license, copy it to a folder on your machine 
and type the path to the file.

Note  If you are installing as a non-admin user you must supply 
license information about this screen.

8. Click Next.
The Ready to Install the Program screen is displayed. 

The settings you defined in the previous steps are displayed. Use the Back 
button if you want to change any of your settings.

If you want to create a desktop shortcut, select the check box.

9. Click Install.
10. When all the files are copied, the Finish screen is displayed.

The Rational DOORS client is installed and the Rational DOORS for Rational 
Quality Manager Interface Client files are installed in the 
\DOORS\9.2\RQMInterface\Client\ directory.

The Rational DOORS for Rational Quality Manager Interface server

To install the Rational DOORS for Rational Quality Manager Interface 
server:
1. Follow step 1 to step 10 in “Installing the Rational DOORS client,” on page 

12.

2. On the The Setup Type screen select the Custom setup type, and click 
Next.
The Custom Setup screen is displayed, with DOORS already selected.

3. Select Rational Quality Manager Interface Server, click the icon, and 
select an installation option.
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Installing Rational DOORS for Rational Quality Manager Interface

4. Click Next.
The DOORS Database Server Settings screen is displayed.

5. Type the port number the Rational DOORS database server is using in the 
Database Port field, and the name of the Rational DOORS database server 
machine in the Database Host field, and then click Next.
The Rational Quality Manager Interface screen is displayed.

6. Enter the following details:

7. Click Next.
The Rational Quality Manager Interface DOORS User screen is 
displayed.

8. Enter the following details:

Field name Details

RQMI Server Port Number Type the port number the Rational 
DOORS for Rational Quality 
Manager Interface server.

RQM Server Type the name of the Rational 
Quality Manager server machine.

RQM User Type the user name of the Rational 
Quality Manager user.

RQM Password Type the password of the Rational 
Quality Manager user.

RQM Port Type the port number the machine 
where Rational Quality Manager is 
installed.

Field name Details

DOORS User Type the user name of the Rational 
DOORS user.

DOORS User Password Type the password of the Rational 
DOORS user.
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9. Click Next.
The License Information screen is displayed.

10. If you do not have details of your license, select Supply license 
information later.
If you know the location of your Rational DOORS license, type the 
information in the appropriate field.

• License Server

If you are using a floating license, enter the location of the license server 
in the form port@host, for example 19353@licenseserver.

• Local License File

If you have a node-locked license, copy it to a folder on your machine 
and type the path to the file.

Note  If you are installing as a non-admin user you must supply 
license information about this screen.

11. Click Next.
The Ready to Install the Program screen is displayed. 

The settings you defined in the previous steps are displayed. Use the Back 
button if you want to change any of your settings.

If you want to create a desktop shortcut, select the check box.

12. Click Install.
13. When all the files are copied, the Finish screen is displayed.

The Rational DOORS client is installed and the Rational DOORS for Rational 
Quality Manager Interface Server files are installed in the 
\DOORS\9.2\RQMInterface\Server\ directory.
For more information about Rational DOORS for Rational Quality Manager 
Interface, see its own documentation set.

Silent installation
Silent installation is supported with Rational DOORS 9.2. This means that rather 
than having to install Rational DOORS from scratch, choosing the same options 
time and time again, you can create an installer that records your preferred 
settings once and then allows you to install in a more cost efficient and timely 
manner.
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Starting Rational DOORS

To run a silent installation, run each product installer from the command line. 
For the Rational DOORS database server, enter a command in the following 
format:

C:\doors_server\setup.exe /s /v"/l*v 
\"C:\doors_server\install.log\" /qn 
PORTNUMBER=\"36677\" 
DATABASEDIR=\"C:\Program Files\IBM\Rational\DOORS\9.2\data\" 
INSTALLDIR=\"C:\Program Files\IBM\Rational\DOORS\9.2\""

For the Rational DOORS client, enter a command in the following format:
setup.exe /s /v"/l*v  
\"C:\doors_client\install.log\" /qn 
INSTALLDIR=\"C:\Program Files\IBM\Rational\DOORS\" 
CLIENTDATA=\"36677@server_machine\" 
TLLICENSESERVER=\"19353@license_server\" 
LAPAGREE=\"Yes\"

Note  If you are running silent installation on Windows Vista, you 
need to make sure that User Account Control is switched off.

When you script Rational product installations, you must do so in the following 
order:
First, any of Rational DOORS, Rational Synergy, Rational Change, and Rational 
Tau. Next, Rational DOORS Analyst Add On. Finally, all other products and 
integrations.
If there is an error, a silent installation program does not display any dialog 
boxes. Instead, status information for the silent installation is recorded in a log 
file called install.log created in the command lines. You can specify any name 
and location you want.

Starting Rational DOORS

For installations that point to an empty data folder

1. Click Start > All Programs > IBM Rational >IBM Rational DOORS 
9.2.

A Rational DOORS report is displayed.

2. Click OK.

The Change Password dialog box is displayed.

3. Type the password you want to use for the Administrator user into the New 
password and Confirm new password fields. The password must be at 
least six characters long.
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4. Click OK.

Note  Make a note of this password. If you forget it, you have 
to contact Support.

5. The DOORS Explorer, and the Welcome Screen are displayed.

6. Click Close to dismiss the Welcome Screen.

7. Create a user account.

As the Administrator account is for use in emergencies only, you need to 
create a user account to use next time you log on to Rational DOORS:

a. Click Tools > Manage Users.

b. On the Users tab, click New.

c. Type a user name in the Username box.

d. Click the Database Manager user type.

e. Click OK.

f. Click OK.

8. Exit Rational DOORS (click File > Exit).
Do not remain logged on as the Administrator user.

For installations that point to existing Rational DOORS data

1. Click Start > All Programs > IBM Rational >IBM Rational DOORS 
9.2.

Rational DOORS is loaded and the Rational DOORS login screen is 
displayed.

2. Type your Rational DOORS user name and password and click OK. If you 
do not have a Rational DOORS user name, contact your Rational DOORS 
administrator.

3. The Database Explorer is displayed.

RDS, the Rational DOORS database and UUIDs
When you use the Rational Directory Server (RDS), two files are created in the 
data subfolder (for example, C:\Program 
Files\IBM\Rational\DOOORS\9.2\data\):

• tds_valid_id.txt

• tds_registered.txt
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These files are used to associate the database with a Universally Unique Identifier 
(UUID).

tds_valid_id.txt
This file indicates that the repository identifier stored in the database is a valid 
UUID obtained from RDS. As long as this file is present, the database cannot be 
registered with a different UUID.
If you want to deploy a copy of a database as a new database with a different 
UUID, you need to delete this file. If you want to retain the current UUID, you 
must not delete this file.

tds_registered.txt
This file indicates that the repository identifier stored in the database is a valid 
UUID that is recognized by the currently configured RDS. If this file is present, 
the database server does not run unless the UUID is found in the RDS registry.
If you want to redeploy a database with its existing UUID on a new RDS server, 
you need to delete this file. You must also make sure that the tds_valid_id.txt file 
is not deleted.

Installing the Rational DOORS Example Data
An example database that is already populated with data is also supplied.
The example database is used to give new Rational DOORS users the 
opportunity to familiarize themselves with Rational DOORS without having to 
access any of your production data or the need to install a local Rational 
DOORS database server.
To install the Example Data:
1. Ensure that you have the Rational DOORS client already installed on your 

machine.

2. If you have the training database for a previous version of Rational DOORS 
installed on your machine, remove it.

3. Shut down all other applications. In particular, shut down Microsoft Office 
applications, including the Microsoft Office toolbar.

4. Download the Rational DOORS Example Data software from the Web site, 
navigate to the file you downloaded, and double-click it.

The Welcome screen is displayed.

5. Click Next.
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The License Agreement screen is displayed.

6. If you accept the terms of the license agreement, select the I accept... 
option and click Next.
The Ready to Install the Program screen is displayed. 

7. Click Install.
When all the files are copied, the Finish screen is displayed.

8. Click Finish.

9. Run the example database to make sure that it has installed correctly.

Click Start > All Programs > IBM Rational > IBM Rational DOORS 
9.2 Example Data.

Uninstalling Rational DOORS
Use Add or Remove Programs in the Windows Control Panel to remove 
version 9.2 of the Rational DOORS database server, the Rational DOORS 
client, or the Rational DOORS Example Data.

Note  When you uninstall the Rational DOORS Example Data on 
Windows Vista, a warning dialog is displayed. Click 
Automatically close application. The software is 
uninstalled as normal.
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4 Upgrading from version 9.0 and later
This chapter describes how to upgrade to Rational DOORS 9.2 from version 9.0 
and 9.1.

• Information for users upgrading to Rational DOORS 9.2 from 9.0 and 9.1

• What happens to my integrations?

• Migrating data to Rational DOORS 9.2

• Installing Rational DOORS

• Checking your installation

Information for users upgrading to Rational DOORS 9.2 from 9.0 and 
9.1

In all cases, Rational DOORS 9.2 is installed into a new directory named 
\IBM\Rational\DOORS\9.2 by default, and after successful installation version 
9.0 or 9.1 is removed.
You cannot install Rational DOORS 9.2 into the same directory as your current 
installation.
The Start > All Program > IBM Rational menu displays IBM Rational 
DOORS 9.2 after the successful installation of Rational DOORS 9.2.

Data migration
Either:

• Install Rational DOORS 9.2, then copy your version 9.0 or 9.1 data to the 
9.2 data folder

• Enter the path to your version 9.0 or 9.1 data folder in the Database Settings 
screen when you install the Rational DOORS 9.2 database server.

Licensing
You do not need a new software license for Rational DOORS 9.2 if you are 
already running version 9.0 or 9.1, and have a valid maintenance agreement.

Compatibility between version 9.0 and Rational DOORS 9.2
• Version 9.0 clients can connect to a Rational DOORS 9.2 database server.
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• Rational DOORS 9.2 clients can connect to a version 9.0 database server.

• Rational DOORS 9.2 can read version 9.0 data.

• Version 9.0 clients can read Rational DOORS 9.2 project or module archives 
and partitions.

Compatibility between version 9.1 and Rational DOORS 9.2
• Version 9.1 clients can connect to a Rational DOORS 9.2 database server.

• Rational DOORS 9.2 clients can connect to a version 9.1 database server.

• Rational DOORS 9.2 can read version 9.1 data.

• Version 9.1 clients can read Rational DOORS 9.2 project or module archives 
and partitions.

What happens to my integrations?
When you upgrade from version 9.0 or 9.1 to 9.2, and you want to run your 
integrations with Rational DOORS 9.2, you need to reinstall them.
If you upgrade your Quality Center Integration to run with Rational DOORS 
9.2, you can no longer use or create data connections to 8.3 databases.

Migrating data to Rational DOORS 9.2
For safety, it is critical that you make a backup of your Rational DOORS data 
before attempting to migrate. Follow these steps:

1. Stop the Rational DOORS database server and copy the Rational DOORS 
data directory to the directory that your Rational DOORS 9.2 database 
server is using.

2. Start the Rational DOORS 9.2 database server.

To initiate the migration, the Rational DOORS Administrator must log on 
from a Rational DOORS 9.2 client and confirm that the data is to be 
migrated. No-one can use Rational DOORS until migration is completed. 
The Rational DOORS client can be on the Rational DOORS database 
server machine, or on a different machine.

If the Administrator does not successfully log on, or does not confirm that 
migration is required, the migration is not performed.

3. Select Start > Program Files > IBM Rational > IBM Rational DOORS 
9.2.

The login screen is displayed.
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Note  If the login screen is not displayed, you have not copied 
your existing data to the correct directory. If you chose 
to migrate your data using archive and restore, the dialog 
is not displayed.

4. Type the Administrator password. No other Rational DOORS user can log 
on to the unmigrated database.

If you do not know your Administrator password, contact your local 
Support department

After successful login, a confirmation dialog is displayed.

5. Click Confirm to begin the migration.

Note  The migration might only take a few seconds to 
complete, depending on the size of your data.

When the migration is complete, the Database Explorer is displayed. 

If you have a dbadmin password, you need to perform these additional 
steps:

a. Log off and stop the Rational DOORS database server.

b. Reset the dbadmin password:

Open a DOS command prompt, navigate to the bin directory and enter 
a command in the following format:
doorsd -R <newpassword> -s <datadirectory>

c. Restart the Rational DOORS database server.

You can now access the data and other Rational DOORS users can log on to 
Rational DOORS 9.2.

Installing Rational DOORS
For information about installing Rational DOORS, see the appropriate chapter.

• “New installation of Rational DOORS on Windows,” on page 9

• “Installing the Rational DOORS server on UNIX,” on page 37

Checking your installation

For installations that point to an empty data folder

1. Click Start > Programs > IBM Rational > IBM Rational DOORS 9.2.
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A report is displayed.

2. Click OK.

The Change Password dialog box is displayed.

3. Type the password you want to use for the Administrator user into the New 
password and Confirm new password fields. The password must be at 
least six characters long.

4. Click OK.

Note  Make a note of this password. If you forget it, you have 
to contact Support.

5. The Database Explorer and the Tip of the Day are displayed.

6. Click OK to dismiss the Tip of the Day screen.

7. Create a user account.

As the Administrator account is for use in emergencies only, you need to 
create a user account to use next time you log on to Rational DOORS:

a. Click Tools > Manage Users
b. On the Users tab, click New
c. Type a user name in the Username box

d. Click the Database Manager user type

e. Click OK
8. Exit Rational DOORS (click File > Exit).

Do not remain logged on as an Administrator user

For installations that point to existing v9 data
1. Click Start > Programs > IBM Rational > IBM Rational DOORS 9.2.

Rational DOORS is loaded and the login screen is displayed.

2. Type your user name and password and click OK. If you do not have a user 
name, contact your Rational DOORS administrator.

3. The Database Explorer is displayed.
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5 Upgrading from version 5, 6, 7 or 8
This chapter discusses what you need to consider when you are upgrading to 
Rational DOORS 9.2 from version 5, 6, 7 or 8.
It contains information about update paths, licensing, and migrating your data.
The installation procedure is the same whether you are upgrading to Rational 
DOORS 9.2 or installing it from scratch. For information about the installation 
procedure, follow the appropriate links in the text.

• Migration paths

• Does Rational DOORS 9.2 overwrite version 8 or 7?

• What do I do with my existing Rational DOORS data?

• How does licensing change?

• What happens to my integrations?

• Can I install and set up in phases?

• What do the new installation options mean?

• Upgrading and migrating data

• Installing Rational DOORS

Migration paths
This section answers the following questions:

• Can I migrate directly from version 5?

• Can I migrate directly from version 6?

• Can I migrate directly from version 7?

• Can I migrate directly from version 8?

Can I migrate directly from version 5?

You cannot migrate data directly to Rational DOORS 9.2 from version 5. Data 
must first be migrated to version 6.0 SR1 format. It can then be migrated to 
Rational DOORS 9.2. You do not have to upgrade all of your version 5 clients to 
version 6.0 SR1. Only the version 5 database needs to be migrated.
Migrate your data in the following way:
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1. Install a version 6.0 SR1 Complete Server Installation, accepting the default 
data directory.

2. Copy your version 5 database to this default directory.

3. Run version 6.0 SR1.

4. Log on as Administrator.

5. Click Confirm to migrate your data.

Caution  You must complete the data migration from version 5 to 
version 6.0 SR1 by running the Module Migrator DXL. 
This DXL can be obtained by contacting Support.  
If you are migrating a large database, you can run the 
module migrator DXL on more than one Rational 
DOORS client, as long as each client is running on a 
different machine. This DXL allows you to migrate 
different sections of the data at the same time. Do not 
run more than on Rational DOORS client on any one 
machine at the same time when running the Module 
Migrator DXL.

When you have completed the data migration from version 5 to version 6.0 SR1, 
you can migrate the data from version 6.0 SR1 to Rational DOORS 9.2. For 
information, see “Upgrading and migrating data,” on page 32.

Can I migrate directly from version 6?
You can migrate data directly to Rational DOORS 9.2 from version 6.0 SR1 and 
later.

Can I migrate directly from version 7?
You can migrate data directly to Rational DOORS 9.2 from version 7.

Can I migrate directly from version 8?

You can migrate data directly to Rational DOORS 9.2 from version 8.

Does Rational DOORS 9.2 overwrite version 8 or 7?
Rational DOORS 9.2 does not overwrite version 8 or 7. The following defaults 
apply when you install Rational DOORS 9.2 on Windows:

• Rational DOORS 9.2 is installed to a new directory named 
\IBM\Rational\DOORS\9.2.
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What do I do with my existing Rational DOORS data?

• A new label, IBM Rational DOORS 9.2, is added to the Start > All 
Programs > IBM Rational DOORS menu.

• The Rational DOORS database server service is called DOORS DB Server 
9.2.

Note  You can install multiple database server services on your 
PC with Rational DOORS 9.2. For more information 
see the Managing Rational DOORS manual, which is 
available from the Rational Lifecycle Solutions DVD 
and from the Web site at www.ibm.com/software/
awdtools/doors/support/doc.html.

• The Rational DOORS database server port number defaults to 36677, 
which was also the default for previous versions. If you want to be able to 
run your existing database server and a Rational DOORS 9.2 database server 
from your machine, make sure that the 9.2 database server runs on a 
different port.

• By default, the Rational DOORS 9.2 database server points to an empty data 
directory in the Rational DOORS 9.2 directory. Do not change this default 
path; it gives you more control over how and when you migrate your existing 
data. For information about the options available, see “What do I do with 
my existing Rational DOORS data?,” on page 29.

• The Rational DOORS 9.2 client installs to a new directory. By default, this 
directory is C:\Program Files\IBM\Rational\DOORS\9.2. Your 
previous version is not overwritten, and you can run version 7 or 8 and 
Rational DOORS 9.2 in parallel on the same machine.

These defaults do not apply to UNIX. For information about upgrading to on 
UNIX, see “Installing the Rational DOORS database server,” on page 37.

What do I do with my existing Rational DOORS data?
Caution  Make a copy of your data directory before installing 

Rational DOORS 9.2, or migrating any data to Rational 
DOORS 9.2. Once you have migrated your data to 
Rational DOORS 9.2 format, you cannot reverse the 
migration.

You have four options for migrating existing data to Rational DOORS 9.2:

• Stop the current DOORS database server, copy the Rational DOORS data 
directory to the directory that your Rational DOORS 9.2 database server is 
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using, then restart the Rational DOORS database server. Run a Rational 
DOORS 9.2 client and log on as the Administrator user.

This option gives you the maximum amount of control over when you 
migrate your data. You can install your Rational DOORS database server, 
and all the Rational DOORS clients, pointing them all to the empty data 
directory. None of your Rational DOORS 9.2 clients can access your data 
and migrate it until you are ready to do so. When you are ready to migrate 
your data, you can copy it to the empty directory and run a Rational 
DOORS client against it. When you log on as the Administrator user, your 
data is migrated to Rational DOORS 9.2.

• Point the Rational DOORS 9.2 database server at the Rational DOORS data 
directory when you install Rational DOORS 9.2, then run a Rational 
DOORS client and log on as Administrator.

Make sure that you have:

a. Made a copy of the Rational DOORS data directory.

b. Ensured that the data is ready to migrate.

Bear in mind that any Rational DOORS client using the Rational DOORS 
9.2 database server who has access to the Administrator password could 
migrate the data.

• Archive the projects you want to migrate, then restore them to Rational 
DOORS 9.2.

Only use this option for initial testing of Rational DOORS 9.2. Using 
archive and restore as a means of migrating data is time consuming. It also 
results in the loss of access controls and cross-project links.

• Make a copy of your current Rational DOORS data directory. Access the 
copied data directory from a version 7 or 8 client, and delete the projects and 
folders that you do not want to migrate to Rational DOORS 9.2.

This option allows you to implement a phased migration of your Rational 
DOORS data. However, after the initial data migration the remaining 
Rational DOORS data must be migrated to Rational DOORS 9.2 using 
archive and restore. Using this method to migrate data is time consuming. If 
you archive and restore data from the same master database that was 
migrated, access controls and cross-project links are preserved.

How does licensing change?
The action you need to take depends on the version you are running, and 
whether you have a valid maintenance agreement:
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What happens to my integrations?

• If you are running version 8.2 or 8.3, and you have a valid maintenance 
agreement, you do not need a new license to install and run Rational 
DOORS 9.2.

• If you are running version 8.2 or 8.3, and do not have a valid maintenance 
agreement, a message is displayed:
The FEATURE name DOORS with version 2009.0601 cannot be found. 
License server does not support this version of the feature

If this message is displayed, you need to obtain a new license.

• If you are running a version earlier than 8.2, you need a new license to run 
Rational DOORS. You also need to install either version 1.3, 1.4 or 1.5 of 
the Rational License Server TL.

When version 8.2 was released, we upgraded the version of FLEXnet to v11.5, 
and we changed all Rational DOORS licenses to use the Telelogic vendor 
daemon instead of the Rational DOORS daemon. This daemon allowed you to 
merge all of your Telelogic licenses into one license key. The default port number 
used for licensing was changed to 19353; the previous port used for licensing 
was 7192.
Rainbow dongles are no longer supported with Rational DOORS. Customers 
who have previously used Rainbow dongles must contact their local Support 
department. Other existing hardware licenses do not need to be replaced.
For more information about licensing, see the Rational License Server TL Licensing 
Guide, which is available from the Rational Lifecycle Solutions DVD and from 
our Web site at http://publib.boulder.ibm.com/infocenter/rsdp/v1r0m0/
index.jsp.

What happens to my integrations?
When you upgrade, you need to upgrade your integrations too. New versions of 
all the integrations are being released, and are available from:

• The Rational DOORS Add Ons CD

• The Rational DOORS for HP Quality Center Interface CD

• The Rational DOORS for Serena PVCS Version Manager Interface CD

• The Rational Web site

Can I install and set up in phases?
As Rational DOORS 9.2 does not overwrite previous installations, you can 
install your Rational DOORS database server and all your Rational DOORS 
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clients alongside the versions you are currently using. You can choose when to 
migrate your data. If you want some users to start using the new Rational 
DOORS version while others continue using the old one, they can do so as long 
as you have made sure that the Rational DOORS 9.2 database server is using a 
different port than your existing database server.

What do the new installation options mean?
The installation options changed after version 8.0.

Upgrading and migrating data
• Version 7 and version 8 clients cannot connect to a Rational DOORS 9.2 

database server.

• Rational DOORS 9.2 clients cannot connect to version 7 or version 8 
database servers.

• Rational DOORS 9.2 can read version 5, version 6.0 SR1, version 7 or 
version 8 project and module archives.

• Version 7 and version 8 clients cannot read Rational DOORS 9.2 project or 
module archives, or partitions.

• Rational DOORS 9.2 clients cannot read version 7 or version 8 partitions. 
Partitions must be rejoined or recovered before you migrate data to Rational 
DOORS 9.2.

• CPS review cycles do not have to be completed before you migrate your data 
to Rational DOORS 9.2.

v9/v8 v7.1 v6.0 SR1

DOORS Client Installation DOORS Standard End User DOORS Client 
Installation

DOORS Database Server 
Installation

DOORS/ERS Complete 
Server Installation

DOORS Complete 
Server Installation

DOORS Laptop/Non-
networked PC

DOORS Complete 
Server Installation

Workstation Client DOORS Remote 
Access Client
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Upgrading and migrating data

If a version 7 or version 8 client tries to connect to the Rational DOORS 9.2 
server, it is not allowed to connect and a message is displayed:
Cannot connect to server. The network is busy.

Migrating data to Rational DOORS 9.2
For safety, it is critical that you make a backup of your Rational DOORS data 
before attempting to migrate. Follow these steps:

1. Stop the Rational DOORS database server and copy the Rational DOORS 
data directory to the directory that your Rational DOORS 9.2 database 
server is using.

2. Start the Rational DOORS 9.2 database server.

To initiate the migration, the Rational DOORS Administrator must log on 
from a Rational DOORS 9.2 client and confirm that the data is to be 
migrated. No-one can use Rational DOORS until migration is completed. 
The Rational DOORS client can be on the Rational DOORS database 
server machine, or on a different machine.

If the Administrator does not successfully log on, or does not confirm that 
migration is required, the migration is not performed.

3. Select Start > Program Files > IBM Rational > IBM Rational DOORS 
9.2.

The login screen is displayed.

Note  If the login screen is not displayed, you have not copied 
your existing data to the correct directory. If you chose 
to migrate your data using archive and restore, the dialog 
is not displayed.

4. Type the Administrator password. No other Rational DOORS user can log 
on to the unmigrated database.

If you do not know your Administrator password, contact your local 
Support department

After successful login, a confirmation dialog is displayed.

5. Click Confirm to begin the migration.

Note  The migration might only take a few seconds to 
complete, depending on the size of your data.

When the migration is complete, the Database Explorer is displayed. 
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If you have a dbadmin password, you need to perform these additional 
steps:

a. Log off and stop the Rational DOORS database server.

b. Reset the dbadmin password:

Open a DOS command prompt, navigate to the bin directory and enter 
a command in the following format:
doorsd -R <newpassword> -s <datadirectory>

c. Restart the Rational DOORS database server.

You can now access the data and other Rational DOORS users can log on to 
Rational DOORS 9.2.

Installing Rational DOORS
For information about installing Rational DOORS, see the appropriate chapter.

• “New installation of Rational DOORS on Windows,” on page 9

• “Installing the Rational DOORS server on UNIX,” on page 37
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6 Installing and using Rational DOORS on 
Citrix

This chapter describes how to install Rational DOORS on Citrix. It contains the 
following:

• Supported platforms

• Installation guidelines

• Environment specifications

• Configuring external links

Supported platforms
Rational DOORS 9.2 is supported on:

• Citrix XenApp 5.0 (Advanced) on Windows 2003 Server Standard and 
Enterprise Edition (32 bit and 64 bit), using the Citrix ICA client v 
10.00.52110 on Windows XP.

Although it might be possible for Rational DOORS 9.2 to work with other 
versions of Citrix on other supported Rational DOORS platforms, they have not 
been tested and are not supported.

Installation guidelines
Terminal services must be activated on the host machine, then Citrix can be 
installed. These steps must take place before any applications are installed. At 
installation of Citrix, it is useful to rename the drives (for example, change the 
drives from A: C: and D: to M: N: and O:). Making this change allows the Citrix 
clients to map their local drives (through redirection) to the drive letters of A: C: 
and D:. Also, increase the swap file to 2.5 times the amount of memory available. 
Also increase the registry file size appropriately to accommodate the multiple 
current_user_keys required.
To install Rational DOORS 9.2 on Citrix you must be in “install mode”.
Configure Rational DOORS 9.2 to display in “Seamless mode”. You might 
experience problems if you display in “Desktop mode”.
As a result of product performance enhancements, the Rational DOORS 9.2 
client only displays colors correctly for text highlighting when using the 16 bit 
color depth resolution in the Citrix ICA client.
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Environment specifications
For the best performance, install the Rational DOORS database server on a 
different machine to the Citrix server. To optimize performance, place both 
machines as geographically close to one another as possible. The Rational 
DOORS license server can be located on either machine, or a separate machine.
For information on Rational DOORS Integrations and the Citrix environment, 
see the integration’s own user documentation.

Configuring external links
You need to configure Rational DOORS to allow external links to access 
locations in Rational DOORS through Citrix.
To configure external links:

1. On the Citrix server, publish protocolhandler.exe to accept parameters:
C:\Program Files\IBM\Rational\DOORS\9.2\bin\protocolhandler.exe 
%*

2. On the desktop where the Citrix Rational DOORS client is accessed, copy 
the following to a .reg file and run it to add it to the registry: 
  Windows Registry Editor Version 5.00
  [HKEY_CLASSES_ROOT\doors]
  @="URL:DOORS protocol"
  "URL Protocol"=""
  
  [HKEY_CLASSES_ROOT\doors\Default Icon]
  @=""
  
  [HKEY_CLASSES_ROOT\doors\shell]
  [HKEY_CLASSES_ROOT\doors\shell\open]
  [HKEY_CLASSES_ROOT\doors\shell\open\command]
  @="\"C:\\Program Files\\Citrix\\ICA Client\\pn.exe\" /
pn:DOORS_CITRIX /app:protocolhandler /param:\"-r 120 -url %1\""

• DOORS_CITRIX is the application set name containing the 
protocolhandler and the Rational DOORS applications.

• protocolhandler is the application name as published in the Citrix server.

• -r 120 -url %1 are the parameters that are passed to the protocolhander 
application in the Citrix server. When you click a URL, %1 is replaced by the 
URL string.

When you click an external link, it opens.
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7 Installing the Rational DOORS server on 
UNIX

This chapter describes how to install and set up version 9.2 of Rational DOORS 
on UNIX computers. It contains the following:

• Understanding UNIX installations

• Installing the Rational DOORS database server

Understanding UNIX installations
The Rational Lifecycle Solutions DVD contains the files for installing 
Rational DOORS servers on UNIX. These files can also be downloaded from 
our Web site at http://www.ibm.com/software/awdtools/doors.
The following files are available. 

• solaris_server.zip
• hpux_server.zip
• linux_server.zip

Installing the Rational DOORS database server
To use the UNIX versions of the Rational DOORS server in a traditional client-
server configuration, install the Rational DOORS database server first on the 
server machine and then install Rational DOORS on Windows client machines 
but ensure that they are connecting to the database server on the port serving 
the Rational DOORS data.
If you are upgrading from a previous version of Rational DOORS, read the 
chapter entitled “Upgrading from version 5, 6, 7 or 8,” on page 27.
To install the Rational DOORS database server:
1. Check that you meet the system requirements. Details of system 

requirements are on our Web site at http://www-01.ibm.com/software/
awdtools/doors/sysreqs/.

2. If you are installing Rational DOORS for the first time, go to Step 4.

3. If you are reinstalling, stop the Rational DOORS database server.

a. Change your working directory to $DOORSHOME/bin.
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b. Enter the following command:
dbadmin -data port@computer -killserver [-password password]

See the following table for what each parameter means.

4. Log on as root. The installation must be performed using the root account.

5. If you are installing Rational DOORS for the first time, create a non-
privileged user account to own the Rational DOORS data and application 
files.

Create an account called doors. We call this user the Rational DOORS 
owner.

6. Set up the directory you want to install Rational DOORS in (the Rational 
DOORS home directory):

a. Create the Rational DOORS home directory.

b. Use the chown command to set the owner of the new directory to the 
Rational DOORS owner.

c. Set the $DOORSHOME environment variable to point to the new directory.

7. You can either install from the Rational Solutions DVD or from Rational 
DOORS software downloaded from the Rational Web site.

If you downloaded the software from the Web, uncompress the archive to a 
temporary location on your computer, and go to Step 8.

If you are installing Rational DOORS from DVD:

a. Put the Rational Lifecycle Solutions DVD into your DVD-ROM 
drive.

b. Mount it.

Where Is

port The port the server is using (by default, 36677).

computer The name of the computer the server is running on.

password The server password (omit the -password switch if the 
password is currently blank).
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Installing the Rational DOORS database server

The following table describes how to mount your DVD-ROM drive:

Note  On Solaris and Linux, if the volume manager is 
configured, it automatically mounts the DVD-ROM.

c. Navigate to the Rational DOORS UNIX server directory on the DVD, 
and uncompress the server archive file you need to a temporary location 
on your computer.

8. Run the installation script, giving the full path including the disk device. For 
example, if you extracted the archive to /mydisk/temp, enter:
/mydisk/temp/doors_9/unix/bin/instdoor.sh

9. Follow the instructions on your screen to install Rational DOORS.

10. Answer the prompts on the screen:

a. Enter path to DVD-ROM device or Rational DOORS distribution:
[/cdrom]

b. Enter y at the second prompt, to install the Rational DOORS database 
server:
Install package DOORS_SERVER [y]: y

c. Enter the path to the Rational DOORS home directory you created in 
Step 6.

d. Enter n or y at the prompt:
Install DOORS SERVER Interface Services [n]: 

If you enter y, the Rational DOORS server interface services, which 
allow Rational DOORS to interface with selected other products, for 
example Rational Requirements Composer, are installed. If you enter y, 
go to either “Installing the Rational DOORS server interface services 
on Solaris,” on page 61 or “Installing the Rational DOORS server 
interface services on Linux,” on page 71 to continue this procedure.

If you enter n, the Rational DOORS server interface services are not 
installed.

Platform Example command

Solaris mount -r -F hsfs /dev/sr0 /cdrom

HP-UX mount -r -F cdfs /dev/dsk/c0t2d0 /cdrom

Linux® mount /dev/cdrom
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e. Enter the name of the Rational DOORS owner (by default, doors).

f. Confirm that you want to install the server.

g. The installation script then confirms all the installation options and 
installs the files. Press ENTER when the installation finishes.

11. Edit the startup file of the Rational DOORS owner.

The following table shows the lines you must add or edit:

12. Start the Rational DOORS database server:

a. Log on as the Rational DOORS owner user.

b. Change your working directory to $DOORSHOME/bin.

c. Enter the following command:
./doorsd &

Note  If you use the Korn shell and do not use “doorsd 
&” in a system startup script, execute the following 
command instead:

“nohup doorsd &”

Startup file Code

Bourne or K shell 
.profile 

DOORSHOME=doors-home-path

SERVERDATA=datapath

PATH=$DOORSHOME/bin:$PATH

PORTNUMBER=database-server-port-number

export DOORSHOME SERVERDATA PATH PORTNUMBER 

DOORSDATA

C shell .login setenv DOORSHOME doors-home-path
setenv SERVERDATA datapath

set path=($DOORSHOME/bin $path)

setenv PORTNUMBER database-server-port-number
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8 Installing the Rational DOORS server 
interface services on Windows

This chapter describes how install and set up the Rational DOORS server 
interface services component on Windows.
This chapter contains the following:

• Introduction

• The interface services components

• Installing the interface services components

• Setting up the components

• Running multiple Interoperation Servers

• Starting the system

• Configuring interface services

• Shutting down the system

• Running interface services and Rational DOORS Web Access on the same 
machine

• Uninstalling the interface services

Introduction
When you select the Custom setup type on the Setup Type screen of the 
Database Server Installation, you install both the Rational DOORS database 
server and the Rational DOORS server interface services (interface services), 
which allows Rational DOORS to interface with selected integration products.
If you only want to install the Rational DOORS database server, follow the steps 
in “Installing the Rational DOORS database server,” on page 9.
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The interface services components
Installing the interface services involves the installation of a number of discrete 
components. These components are copied to your machine.

Installing the interface services components
You must install several components to run the interface services. Follow the 
instruction in these topics to install the components:

• Installing the Rational DOORS database server

• Installing the Interoperation Server

• Installing the interface services server and the interface services broker

Component Description

Interface services server An adaptation of Apache Tomcat. 
Tomcat is an application server that 
executes Java® servlets and renders web 
pages that include JavaServer Pages code.
You need to run the adapted version of 
Tomcat that is supplied by Rational as 
one of the Rational DOORS interface 
services bundled components.

Interface services broker An adaptation of Apache ActiveMQ. 
ActiveMQ is an open source message 
broker that implements the Java Message 
Service (JMS).
The broker is supplied by Rational as one 
of the Rational DOORS interface 
services bundled components.

Rational DOORS database server The data you are accessing is stored in 
your Rational DOORS database server.

Interoperation Server A Rational DOORS client that is run 
using the -interop command-line 
parameter.
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Installing the Rational DOORS database server

You need to install the database server using the Custom setup type on the 
Setup Type screen.
To install the Rational DOORS database server using the Custom setup 
type:
1. Follow step 1 to step 8 in “Installing the Rational DOORS database server,” 

on page 9.

2. On the Setup Type screen select the Custom setup type.

The Custom Setup screen is displayed.

3. Click the DOORS server interface services icon, and select an installation 
option.

4. Click Next.
The DOORS Database Server Settings screen is displayed.

5. Enter the Port Number and the Data Directory.

a. In Port Number, type the port number to be used by your Rational 
DOORS database server. Do not use a number lower than 1000. The 
default port used by Rational DOORS is 36677.

b. In Data Directory, type the path to the directory you want to use for 
your Rational DOORS database. This directory must be on the local 
machine and is where your data and user information is stored. Rational 
DOORS does not support mapped drives for data.

c. Click Next.
Note  If the port you specified is already being used by another 

application, a message is displayed. Click OK, type a 
different port number and click Next.

The Ready to Install the Program screen is displayed.

The settings you defined in the previous steps are displayed. Use the Back 
button if you want to change any of your settings.

6. Click Install.
7. When all the files are installed, the Finish screen is displayed. Click Finish 

to complete the installation.



Installing the Rational DOORS server interface services on Windows

44    Rational DOORS Installation Guide

Installing the Interoperation Server

The Interoperation Server is the current Rational DOORS client. Installing the 
Interoperation Server is a simple matter of installing a Rational DOORS client.
To install the Interoperation Server:
1. Choose the machine you want to run the Interoperation Server on.

2. Install the Interoperation Server by performing a normal Rational DOORS 
Client installation. Make sure that you enter the details for the correct 
Rational DOORS database server. For information about installing the 
client, see “Installing the Rational DOORS client,” on page 12.

Installing the interface services server and the interface services broker
To install the interface services server and the interface services broker:
• Extract interfaces\festival-win32.zip to your chosen folder, then set 

up your components, by following the instructions in the next section.

Setting up the components
You need to enable the components to communicate correctly with one another.
You need to set up:

• The interface services server to communicate with the interface services 
broker, the license server, and the appropriate Rational DOORS database 
repository

• The Rational DOORS database server to communicate with the broker

The interface services broker does not need to know the location of any of the 
other components.
Optionally, you can also set up multiple Interoperation Servers.

Identifying the database Universal Resource Name
The database Universal Resource Name (URN) is used once you start up 
interface services. You need to locate it now, and make a note of it for later use.

1. If it is not already running, start the Rational DOORS database server.

2. Start the Rational DOORS client and log on to the database. 

3. In either the Database Explorer or a module window, click Tools > Edit 
DXL.

4. Type the following DXL script into the DXL input pane:



Rational DOORS Installation Guide           45

Setting up the components

print getDatabaseIdentifier()

5. Click Run to run the program. A 16 digit hexadecimal number is output, for 
example 38f5c98719f27b6d. This forms part of the database URN. In this 
example, the database URN is: urn:telelogic:ers-38f5c98719f27b6d:.

6. Make a note for later use.

Setting up the interface services server
You need to set up the interface services server to communicate with the 
interface services broker, the license server and the appropriate Rational 
DOORS database repository.
The interface services server is configured using the ...\server\festival 
directory. The festival directory contains two subdirectories:

• config

This directory contains festival.xml, the core configuration file within 
the interface services. The festival.xml file:

• Can be configured so that the interface services server communicates 
with the interface services broker and the license server

• Contains the URN of the Repository, which must match the URN you 
identified in “Identifying the database Universal Resource Name,” on 
page 44 or the RDS Repository ID

Note  Do not modify any other files in the config directory 
unless you receive the guidance of Rational support.

• custom

This directory contains a subdirectory containing a file called readme.htm, 
which you can use to configure the Welcome screen.

Example of festival.xml
The festival.xml file is the core configuration file within the interface 
services.

<!-- Brokers we know about -->
      <f:endpoints>
         <f:broker 
            name="GENERALSERVICES" 
            url="tcp://
127.0.0.1:61616?wireFormat.tcpNoDelayEnabled=true"
            user name="" 
            password="" />
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         <f:broker 
            name="DCSERVICES" 
            url="tcp://
127.0.0.1:61616?wireFormat.tcpNoDelayEnabled=true"
            user name="" 
            password="" />
            
         <f:broker 
            name="RMSERVICES" 
            url="tcp://
127.0.0.1:61616?wireFormat.tcpNoDelayEnabled=true"
            user name="" 
            password="" /> 
      </f:endpoints>

<!-- Mapping from Repository IDs to the broker we use to reach 
the repository -->
      <f:mappings>
         <f:repository-mapping 
            enabled="true" 
            endpoint="RMSERVICES"
            name="DOORS ERS Repository"
            repositoryUrn="urn:telelogic:ers-46dd5d7806b96973:" 
/>
      </f:mappings>

      <!-- Configurable system properties -->
      <f:properties>
         <f:property name="licence.server.location" 
value="19353@localhost" />
         <f:property name="display.redirector.urls" 
value="false" />
         <f:property name="published.url.prefix"  
value="http://MYHOSTNAME:8080/doors/redirector/" />  
       </f:properties>

   </f:lsc>
</f:configuration>

Modifying festival.xml

The festival.xml file is the core configuration file within interface services. You 
need to modify entries for f:broker, f:repository-mapping and 
f:properties:

1. In the example, there are three entries that describe where the interface 
services broker is. Edit these entries to point to the url of the machine where 
you installed the interface services broker with the default port (61616). If 
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the interface services broker is on the same machine as the interface services 
server, you do not have to edit these entries.

2. The f:repository-mapping defines the URN of the repository.

a. The name attribute is the name displayed on the interface services logon 
page. You can change this attribute. The default is DOORS ERS 
Repository.

b. The repositoryUrn attribute needs to match the URN of the Rational 
DOORS database server you identified in “Identifying the database 
Universal Resource Name,” on page 44. You must change this attribute.

3. The f:properties entry defines the location of the license server. The 
property name attribute is licence.server.location with the value 
19353@localhost, which is the port number and machine name of the 
license server. Edit this value to point to the location of your license server. 
This location is added to the list of license locations held on your system.

Setting up the Rational DOORS database server

You need to set up the Rational DOORS database server to communicate with 
the interface services broker.
You set up the communication by adding Data Change Notifications (DCN) 
parameters to the command line. DCNs are messages that contain information 
about changes made to Rational DOORS data.
To set up the Rational DOORS database server you need to run dbadmin, 
located in the \IBM\Rational\DOORS\9.2\bin directory on the Rational 
DOORS client machine.
Run dbadmin, in a command line in the following format:

dbadmin -data 36677@myserver -dcnEnable -dcnBrokerUri  
“tcp://myBroker:61616” -dcnChannelName “dcn”

The parameters that are used are:

Parameter Description

–data 36677@myserver Identifies the Rational DOORS 
database server, where 36677 is the 
default port number the database 
server is using and myserver is the 
name of the machine where the 
database server is installed.
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Note  You need to restart the Rational DOORS database server for 
this command to take effect.

Useful DCN commands

Use these commands to check the DCN service status and turn the service off 
and on.

• You can check the DCN service status using the -dcnInfo parameter:
dbadmin -data 36677@myserver -dcnInfo

• You can turn the DCN service off using -dcnDisable and turn it on using 
-dcnEnable:

dbadmin -data 36677@myserver -dcnDisable
dbadmin -data 36677@myserver -dcnEnable

You need to restart the Rational DOORS database server for these 
commands to take effect.

Running multiple Interoperation Servers
Setting up your system to run multiple Interoperation Servers can improve 
performance and increase the availability of the system.
Performance is improved because more modules can be cached, allowing quicker 
access to your data. Interface services have routing logic to perform basic load 
balancing across the Interoperation Servers.
Availability is improved because the system can continue to work if one of the 
Interoperation Servers fails. While one Interoperation Server is down, users can 
continue to access the database using the others.

-dcnEnable Enables the DCNs.

–dcnBrokerUri “tcp://myBroker:61616” Locates the interface services 
broker, where myBroker is the 
machine hosting the broker and 
61616 is the default port that the 
broker uses.

-dcnChannelName “dcn” Sets up the DCN channel. The 
channel name is always dcn.

Parameter Description
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To run multiple Interoperation Servers, start up multiple instances of the 
Interoperation Server.
All the Interoperation Servers must:

• Connect to the same interface services broker

• Use same Rational DOORS database server

The Interoperation Servers can be on different machines. For information, see 
step 3 in “Starting the system,” on page 49.

Starting the system
To start the system, you must start the processes in the following order:

1. Start the interface services broker by running broker.start.bat. This file 
is in the directory where you extracted festival-win32.zip on the 
machine hosting the interface services broker.

2. Start the Rational DOORS database server as s a service on the machine 
hosting the database.

3. Run the Interoperation Server on the machine hosting it with its command-
line attributes in the following format:
doors.exe –interop –data port@myserver –brokerHost myBroker  
–brokerPort

where:

• port is the port number the Rational DOORS database server is using 
and myserver is the name of the machine where the Rational DOORS 
database server is installed

• myBroker is the name of the machine hosting the broker
• brokerport is the port that the broker is using, by default 61616

4. Start the interface services server by running server.start.bat. This file 
is in the directory where you extracted festival-win32.zip on the 
machine hosting the server. It might be slow to start the first time it is run 
because it has to unpack some files.

When you run 1, 3 and 4, there is a “dos box” console for each process. Do not 
close these windows.

Configuring interface services
You can configure the interface services server and broker ports, HTTPS, and 
the Redirector Service:
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• Configuring the interface services server port

• Configuring the interface services broker port

• Configuring HTTPS

• Configuring the Redirector Service

• A note on information security

Configuring the interface services server port
The main way of configuring the interface services server is to edit the 
server.xml file in the conf subdirectory.

1. Open the file.

2. Navigate to the following line:
<!-- Define a non-SSL HTTP/1.1 Connector on port 8080 -->

3. Change the port number in this line:
<Connector port=“8080”

This is the port that the server listens on for HTTP requests.
Once you have completed this edit, save the file, and restart the interface services 
server.

Note  Take care when changing the server.xml file, as incorrect 
edits can lead to a complete loss of system functionality. 
Make a backup of the file before you edit it.

Configuring the interface services broker port

You configure the interface services broker by editing the activemq.xml file in 
the conf subdirectory of the machine hosting the broker and the festival.xml 
file on the machine hosting the interface services server.
In the activemq.xml file, there are entries for <transportConnectors> 
followed by multiple <transportConnect … elements. Each defines a protocol 
and port that the broker listens on.
Open activemq.xml and change the URI attribute in the openwire element, 
which defaults to port 61616:

<transportConnector name="openwire" uri="tcp://
localhost:61616"/>

Once you have completed this edit, save the activemq.xml file.
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Finally, on the machine hosting the interface services server, open the 
festival.xml file and modify the three broker ports (in bold in the following 
example):

<!-- Brokers we know about -->
      <f:endpoints>
         <f:broker 
            name="GENERALSERVICES" 
            url="tcp://127.0.0.1:61616?wireFormat.tcpNoDelayEnabled=true"
            user name="" 
            password="" />
         
         <f:broker 
            name="DCSERVICES" 
            url="tcp://127.0.0.1:61616?wireFormat.tcpNoDelayEnabled=true"
            user name="" 
            password="" />
            
         <f:broker 
            name="RMSERVICES" 
            url="tcp://127.0.0.1:61616?wireFormat.tcpNoDelayEnabled=true"
            user name="" 
            password="" /> 
      </f:endpoints>

Once you have completed this edit, save the festival.xml file, and restart all 
the interface services components.

Note  Take care when changing the activemq.xml file and the 
festival.xml file, as incorrect edits can lead to a complete 
loss of system functionality. Back up the files before you edit 
them.

Configuring HTTPS
The interface services support the use of HTTPS communication between the 
web browser and the interface services server.
To configure HTTPS you need a certificate. You can make one manually for 
testing purposes or you can purchase one from a trusted certificate authority.
You also need to have keystore containing the server certificate. You can create 
and manage a keystore using the standard java keytool facilities as documented 
on the Sun Web site.
You need to define a new connector to allow HTTPS. This is defined in the 
Connector element in the server.xml file in the server’s conf subdirectory.
Open the file and make the changes in bold:

<!-- Delete this line from the file
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<Connector port="8443“ maxHttpHeaderSize="8192" 
maxThreads="150" inSpareThreads="25“ 
MaxSpareThreads="75“ enableLookups="false"  
disableUploadTimeout="true“ acceptCount="100"  
scheme="https" secure="true“ clientAuth="false"  
sslProtocol="TLS" 
keystoreFile="c:\Server\keystore.ks" 
keystorePass="password"  
keystorePass="password"algorithm="IbmX509"
/> 
--> Delete this line from the file

By default, this Connector element is commented out. Deleting the line 
immediately preceding it and immediately after it makes the element active.
The changes to the file

• Set the server to use HTTPS on port 8443

• Use the keystore entries to identify the keystore that contains the server 
certificate

Once you have completed this edit, save the file, and restart the interface services 
server.

Note  Take care when changing the server.xml file, as incorrect 
edits can lead to a complete loss of system functionality. 
Make a backup of the file before you edit it.

For more information about configuring HTTPS and for other methods of 
configuration, see the Tomcat user documentation.

Configuring the Redirector Service
You have to configure the Rational DOORS Redirector Service, the interface 
services server and the Rational DOORS Database Server. 

1. Navigate to the directory where you extracted festival-win32.zip.

2. Open server\festival\config\doorsRedirector.properties in a 
text editor. 

3. Set the doors.url.prefix value to match the database server that is 
serving the interface services in the form doors://host:port/, where 
host is the name of the Rational DOORS Database Server machine and 
port is the port number it uses (typically 36677).

Note  Do not delete the / at the end of this value.
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4. Set the dwa.url.prefix value to match the interface services server, in the 
form http://host:port/dwa/, where host is the name of the interface 
services server machine, and port is the port number it uses (typically 8080).

Note  Do not delete the / at the end of this value.

5. Optionally:

• Disable forwarding from the redirector service to the interface services s 
by setting <entry key="dwa.enable">false</entry> 

• Disable forwarding from the redirector service to Rational DOORS by 
setting <entry key="doors.enable">false</entry> 

6. Save and close the file.

7. Open server\festival\config\festival.xml in a text editor. 

8. Find the line beginning <f:property name="published.url.prefix". 

9. Change MYHOSTNAME to the name of the machine where the Redirector 
Service is installed, then save and close the file. 

Note  Do not delete the / at the end of this value.

10. Start doorsd then configure the Rational DOORS Database Server so that 
generated URLs refer to the Redirector Service. In the bin directory of the 
database server installation, run the command: 
dbadmin -data port@host -urlPrefix http://yourdwaserver:port/
doors/redirector 

where yourdwaserver is the name of the interface services server machine, 
and port is the port number it uses (typically 8080). 

11. Restart the interface services components.

A note on information security

The default deployment of the interface services uses insecure communication 
protocols throughout the stack.
Though the system supports the use of HTTPS to protect communications 
between the browser and the interface services server, there is currently no 
support for secure communication between different server-side components.
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Running interface services and Rational DOORS Web Access on the 
same machine

You can configure the interface services server and broker ports, HTTPS, and 
the Redirector Service:

• Configuring the interface services server port

• Configuring the interface services broker port

• Configuring HTTPS

• Configuring the Redirector Service

• A note on information security

Configuring the interface services server port
The main way of configuring the interface services server is to edit the 
server.xml file in the conf subdirectory.

1. Open the file.

2. Navigate to the following line:
<!-- Define a non-SSL HTTP/1.1 Connector on port 8080 -->

3. Change the port number in this line:
<Connector port=“8080”

This is the port that the server listens on for HTTP requests.
Once you have completed this edit, save the file, and restart the interface services 
server.

Note  Take care when changing the server.xml file, as incorrect 
edits can lead to a complete loss of system functionality. 
Make a backup of the file before you edit it.

Configuring the interface services broker port
You configure the interface services broker by editing the activemq.xml file in 
the conf subdirectory of the machine hosting the broker and the festival.xml 
file on the machine hosting the interface services server.
In the activemq.xml file, there are entries for <transportConnectors> 
followed by multiple <transportConnect … elements. Each defines a protocol 
and port that the broker listens on.
Open activemq.xml and change the URI attribute in the openwire element, 
which defaults to port 61616:
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<transportConnector name="openwire" uri="tcp://
localhost:61616"/>

Once you have completed this edit, save the activemq.xml file.
Finally, on the machine hosting the interface services server, open the 
festival.xml file and modify the three broker ports (in bold in the following 
example):

<!-- Brokers we know about -->
      <f:endpoints>
         <f:broker 
            name="GENERALSERVICES" 
            url="tcp://127.0.0.1:61616?wireFormat.tcpNoDelayEnabled=true"
            user name="" 
            password="" />
         
         <f:broker 
            name="DCSERVICES" 
            url="tcp://127.0.0.1:61616?wireFormat.tcpNoDelayEnabled=true"
            user name="" 
            password="" />
            
         <f:broker 
            name="RMSERVICES" 
            url="tcp://127.0.0.1:61616?wireFormat.tcpNoDelayEnabled=true"
            user name="" 
            password="" /> 
      </f:endpoints>

Once you have completed this edit, save the festival.xml file, and restart all 
the interface services components.

Note  Take care when changing the activemq.xml file and the 
festival.xml file, as incorrect edits can lead to a complete 
loss of system functionality. Back up the files before you edit 
them.

Configuring HTTPS

The interface services support the use of HTTPS communication between the 
web browser and the interface services server.
To configure HTTPS you need a certificate. You can make one manually for 
testing purposes or you can purchase one from a trusted certificate authority.
You also need to have keystore containing the server certificate. You can create 
and manage a keystore using the standard java keytool facilities as documented 
on the Sun Web site.



Installing the Rational DOORS server interface services on Windows

56    Rational DOORS Installation Guide

You need to define a new connector to allow HTTPS. This is defined in the 
Connector element in the server.xml file in the server’s conf subdirectory.
Open the file and make the changes in bold:

<!-- Delete this line from the file
<Connector port="8443“ maxHttpHeaderSize="8192" 
maxThreads="150" inSpareThreads="25“ 
MaxSpareThreads="75“ enableLookups="false"  
disableUploadTimeout="true“ acceptCount="100"  
scheme="https" secure="true“ clientAuth="false"  
sslProtocol="TLS" 
keystoreFile="c:\Server\keystore.ks" 
keystorePass="password"  
keystorePass="password"algorithm="IbmX509"
/> 
--> Delete this line from the file

By default, this Connector element is commented out. Deleting the line 
immediately preceding it and immediately after it makes the element active.
The changes to the file

• Set the server to use HTTPS on port 8443

• Use the keystore entries to identify the keystore that contains the server 
certificate.

Once you have completed this edit, save the file, and restart the interface services 
server.

Note  Take care when changing the server.xml file, as incorrect 
edits can lead to a complete loss of system functionality. 
Make a backup of the file before you edit it.

For more information about configuring HTTPS and for other methods of 
configuration, see the Tomcat user documentation.

Configuring the Redirector Service

You have to configure the Rational DOORS Redirector Service, the interface 
services server and the Rational DOORS Database Server. 

1. Navigate to the directory where you extracted festival-win32.zip.

2. Open server\festival\config\doorsRedirector.properties in a 
text editor. 

3. Set the doors.url.prefix value to match the database server that is 
serving the interface services in the form doors://host:port/, where 
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host is the name of the Rational DOORS Database Server machine and 
port is the port number it uses (typically 36677).

Note  Do not delete the / at the end of this value.

4. Set the dwa.url.prefix value to match the interface services server, in the 
form http://host:port/dwa/, where host is the name of the interface 
services server machine, and port is the port number it uses (typically 8080).

Note  Do not delete the / at the end of this value.

5. Optionally:

• Disable forwarding from the redirector service to the interface services s 
by setting <entry key="dwa.enable">false</entry> 

• Disable forwarding from the redirector service to Rational DOORS by 
setting <entry key="doors.enable">false</entry> 

6. Save and close the file.

7. Open server\festival\config\festival.xml in a text editor. 

8. Find the line beginning <f:property name="published.url.prefix". 

9. Change MYHOSTNAME to the name of the machine where the Redirector 
Service is installed, then save and close the file. 

Note  Do not delete the / at the end of this value.

10. Start doorsd then configure the Rational DOORS Database Server so that 
generated URLs refer to the Redirector Service. In the bin directory of the 
database server installation, run the command: 
dbadmin -data port@host -urlPrefix http://yourdwaserver:port/
doors/redirector

where yourdwaserver is the name of the interface services server machine, 
and port is the port number it uses (typically 8080).

11. Restart the interface services components.

A note on information security

The default deployment of the interface services uses insecure communication 
protocols throughout the stack.
Though the system supports the use of HTTPS to protect communications 
between the browser and the interface services server, there is currently no 
support for secure communication between different server-side components.
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Shutting down the system
To shut down the system you must stop the following processes:

1. Stop the interface services server by running server.shutdown.bat. This 
file is in the directory where you extracted festival-win32.zip on the 
machine hosting the interface services server.

• Stop the Interoperation Server using the “close window” option.

• Stop the Rational DOORS database server using the Windows Control 
Panel.

• Stop the interface services broker by running broker.shutdown.bat. This 
file is in the directory where you extracted festival-win32.zip on the 
machine hosting the interface services broker. The process might take some 
time to end (15-30 seconds), and might report a number of socket warnings 
while shutting down.

Running interface services and Rational DOORS Web Access on the 
same machine

Note  This section assumes you have already installed and 
configured the interface services, the Interoperation Server, 
the Rational DOORS client, the Rational DOORS database 
server, and Rational DOORS Web Access.

There are extra tasks you need to complete if you plan to run the interface 
services and Rational DOORS Wed Access on the same machine.
You need to reset the interface services server port, and then start and stop some 
of the interface services and the Rational DOORS Web Access components to 
pick up the new values:

• Resetting the interface services server port

• Starting and stopping components

Resetting the interface services server port

You need to reset the port number in the server.xml file in the conf 
subdirectory:

1. Navigate to the file.

2. Open the file.

3. Change the Shutdown and Start port numbers.
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4. To change the Shutdown port number, change the port number in the 
following line:
<Server port="8005" shutdown="SHUTDOWN">

5. To change the Start port number, navigate to the following line:
<!-- Define a non-SSL HTTP/1.1 Connector on port 8080 -->

6. Change the port number in the next line:
<Connector port=“8080”

7. Save the file.

Starting and stopping components
You need to start and stop the following components:

• The Rational DOORS Web Access broker

• The Interoperation Server

• The Rational DOORS Web Access server

• The interface services server

Starting and stopping the Rational DOORS Web Access broker

1. Start the Rational DOORS Web Access broker by running 
broker.start.bat. This file is in the directory where you extracted 
festival-win32.zip when you installed the Rational DOORS Web 
Access.

2. Stop the Rational DOORS Web Access broker by running 
broker.shutdown.bat. This file is in the same directory as 
broker.start.bat.

Starting and stopping the Interoperation Server

1. Start the Interoperation Server by running it with its command-line 
attributes in the following format:
doors.exe –interop –data port@myserver –brokerHost myBroker  
–brokerPort

where:

• port is the port number the Rational DOORS database server is using 
and myserver is the name of the machine where the Rational DOORS 
database server is installed

• myBroker is the name of the machine hosting the broker
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• brokerport is the port that the broker is using, by default 61616.

2. Stop the Interoperation Server using the “close window” option.

Starting and stopping the Rational DOORS Web Access server

1. Start the Rational DOORS Web Access server by running 
server.start.bat. This file is in the directory where you extracted 
festival-win32.zip when you installed the Rational DOORS Web 
Access.

2. Stop the Rational DOORS Web Access server by running 
server.shutdown.bat. This file is in the same directory as 
server.start.bat.

Starting and stopping the interface services server

1. Start the interface services server by running server.start.bat. This file 
is in the directory where you extracted festival-win32.zip when you 
installed the interface services.

2. Stop the interface services server by running server.shutdown.bat. This 
file is in the same directory as server.start.bat.

Uninstalling the interface services
Follow these instructions to uninstall the interface services from your system. 

• Uninstall the interface services server by deleting the festival directory

• Uninstall the interface services broker by deleting the festival directory

• Uninstall the Interoperation Server and the Rational DOORS database 
server using Add and Remove Programs in the Windows Control Panel
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9 Installing the Rational DOORS server 
interface services on Solaris

This chapter contains the following:

• Introduction

• The interface services components

• Installing the Rational DOORS database server

• Installing the Interoperation Server

• Installing the interface services server and broker

• Starting the system

• Shutting down the system

• Running interface services and Rational DOORS Web Access on the same 
machine

• Uninstalling interface services

Introduction
During the installation of the Rational DOORS database server, there is a 
prompt asking you whether you want to install the Rational DOORS server 
interface services. When you enter y, you install both the Rational DOORS 
database server and the Rational DOORS server interface services (interface 
services), which allows Rational DOORS to interface with selected integration 
products.
This chapter describes how install and set up the interface services on Solaris.
If you only want to install the Rational DOORS database server, ignore this 
chapter and follow the steps in “Installing the Rational DOORS database 
server”, on page 37. 
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The interface services components
Installing the interface services involves the installation of a number of discrete 
components. These components are copied to your machine.

You must install these components to run the interface services. Follow the 
instruction in these topics to install the components.

Installing the Rational DOORS database server
To install the Rational DOORS database server:
1. Follow step 1 to step 9 in “Installing the Rational DOORS database server”, 

on page 37.

2. Answer the prompts on the screen:

a. Enter path to DVD-ROM device or Rational DOORS distribution:

Component Description

Interface services server An adaptation of Apache Tomcat. 
Tomcat is an application server that 
executes Java servlets and renders web 
pages that include JavaServer Pages code.
You need to run the adapted version of 
Tomcat that is supplied by Rational as 
one of the Rational DOORS interface 
services bundled components.

Interface services broker An adaptation of Apache ActiveMQ. 
ActiveMQ is an open source message 
broker that implements the Java Message 
Service (JMS) 
The broker is supplied by Rational as one 
of the Rational DOORS interface 
services bundled components.

Rational DOORS database server The data you are accessing is stored in 
your Rational DOORS database server.

Interoperation Server A Rational DOORS client that is run 
using the -interop command-line 
parameter.
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b. Enter y at the second prompt, to install the Rational DOORS database 
server:
Install package DOORS_SERVER [y]: y

c. Enter the path to the Rational DOORS home directory you created in 
Step 6 of “Installing the Rational DOORS database server”, on page 37.

d. Enter y at the prompt:
Install DOORS SERVER Interface Services [n]: y

This copies the festival-sol.zip file, which contains the interface 
services server and broker, to your machine. You extract the file and 
install them later.

e. Enter the name of the Rational DOORS owner (by default, doors).

f. Confirm that you want to install the server.

g. The installation script then confirms all the installation options and 
installs the files. Press ENTER when the installation finishes.

3. Edit the startup file of the Rational DOORS owner.

The following table shows the lines you must add or edit:

4. Start the Rational DOORS database server:

a. Log on as the Rational DOORS owner user.

b. Change your working directory to $DOORSHOME/bin.

c. Enter the following command:

Startup file Code

Bourne or K shell 
.profile 

DOORSHOME=doors-home-path

SERVERDATA=datapath

PATH=$DOORSHOME/bin:$PATH

PORTNUMBER=database-server-port-number

export DOORSHOME SERVERDATA PATH PORTNUMBER 
DOORSDATA

C shell .login setenv DOORSHOME doors-home-path

setenv SERVERDATA datapath

set path=($DOORSHOME/bin $path)

setenv PORTNUMBER database-server-port-number
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./doorsd &

Note  If you use the Korn shell and do not use “doorsd 
&” in a system startup script, execute the following 
command instead:

“nohup doorsd &”

Installing the Interoperation Server
To run the interface services on a Solaris system, you must install an 
Interoperation Server.
To install the Interoperation Server:
1. Copy solaris.zip to the machine you want to run the Interoperation Server 

on and log on as root.

2. Create a home directory for the installation.

3. Create a non-privileged account to own the Interoperation Server files. You 
could call this user doors.

4. Navigate to the directory containing solaris.zip and extract it:
unzip solaris.zip

5. Navigate to the directory containing the installers and run the installers:
cd unix/bin

6. Run the installers:
./instdoor.sh

You use this file to install the Interoperation Server.

7. Answer the prompts on the screen:

a. Enter path to CD-ROM device or Rational DOORS distribution.

b. Accept the installation of the Interoperation Server.

c. Enter the path to the home directory you created in Step 2.

d. Enter y to confirm that you want to install the interface services. This 
copies the festival-sol.zip file, which contains the interface 
services server and broker, to your machine. You extract the file and 
install them later.

e. Enter the name of the Rational DOORS owner you set up in Step 3.

f. Confirm the type of installation. Select both the Common installation 
and the Solaris installation.
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8. The installation script then confirms all the installation options and installs 
the files.

9. When the installation finishes, press ENTER. Any updates that are required 
for the account profile that you created to own the Interoperation Server 
files are displayed in the output.

Installing the interface services server and broker
To install the interface services server and the interface services broker:
1. Copy the festival-sol.zip, which is in the interfaces directory of the 

server installation area, to the machine or machines you want to install 
interface services server and broker on. If you want to install the server and 
broker on different machines, repeat the following instructions on each 
machine.

2. Decide which directory you want to install on, and extract festival-
sol.zip to install it.

3. Set the appropriate permissions on the files in the directory structure and 
install the JRE by running the configure-festival.sh script.

a. Navigate to the festival directory.

b. Run the script:
bash configure-festival.sh

Note  The script reports that it is installing JRE. JRE is 
localized to the current directory and does not affect any 
other Java installations on the system.

You are now ready to set up the components to communicate with one another. 
For instructions, see “Setting up the components”, on page 44. 

Note  The instructions in the section entitled “Setting up the 
components”, on page 44 are the same for Windows, Solaris, 
and Linux with one exception. When you set up the Rational 
DOORS database server you need to run dbadmin. On 
Solaris and Linux, dbadmin is located in the $DOORSHOME/
bin directory.

If you want to run multiple Interoperation Servers, see “Running multiple 
Interoperation Servers”, on page 48.
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Starting the system
To start the system you must start the processes in the following order:

1. Log on as the user who owns the Rational DOORS files. This is the user you 
created when you installed the Interoperation Server.

2. Start the broker by running broker.start.sh, which is in the festival 
directory on the machine hosting the broker.

3. Set the following environment variables on the machine hosting the Rational 
DOORS database server.
DOORSHOME=doors-home-path
SERVERDATA=path_to_data_directory
PATH=$DOORSHOME/bin:$PATH
PORTNUMBER=database-server-port-number
export DOORSHOME SERVERDATA PATH PORTNUMBER DOORSDATA

Note  This DOORSHOME variable relates to where the 
Rational DOORS database server is installed.

4. Start the Rational DOORS database server:

a. Log on as the user that owns the Rational DOORS files.

b. Change your working directory to $DOORSHOME/bin.

c. Enter the following command:
./doorsd &

5. Set the following environment variables on the machine hosting the 
Interoperation Server:
DOORSHOME=doors-home-path
DOORSDATA=36677@myserver
PATH=$DOORSHOME/bin:$PATH
export DOORSHOME PATH DOORSDATA

Note  If the installation directory for the database server and 
the Interoperation Server are different, then the required 
profile updates are in conflict. This DOORSHOME variable 
relates to where the Interoperation Server is installed. 
This might be different from the DOORSHOME variable 
used in Step 3.

d. Navigate to $DOORSHOME/bin and run the Interoperation Server with its 
command-line attributes in the following format:
./doors9 -interop –data port@myserver –brokerHost 
myBroker –brokerPort brokerport &
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where: 

• port is the port number the Rational DOORS database server is 
using and myserver is the name of the machine where the Rational 
DOORS database server is installed 

• myBroker is the name of the machine hosting the broker
• brokerport is the port that the broker is using, by default 61616

6. Start the interface services server by running server.start.sh, which is in 
the festival directory on the machine hosting the server.

Shutting down the system
To shut down the system stop the following processes:
1. Stop the interface services server by running server.shutdown.sh script. 

This script is in the festival directory. The process might take some time 
to end (15-30 seconds), and might report a number of socket warnings while 
shutting down. 

2. Stop the Interoperation Server by killing the process.

3. Stop the Rational DOORS database server using the following command 
from $DOORSHOME/bin: 

dbadmin -data port@computer -killserver [-password password]

4. Stop the interface services broker by running the broker.shutdown.sh 
script in the festival directory: The process might take some time to end 
(15-30 seconds), and might report a number of socket warnings while 
shutting down.

Running interface services and Rational DOORS Web Access on the 
same machine

Note  This section assumes you have already installed and 
configured the interface services, the Interoperation Server, 
the Rational DOORS client, the Rational DOORS database 
server, and Rational DOORS Web Access.

There are extra tasks you need to complete if you plan to run the interface 
services and Rational DOORS Wed Access on the same machine.
You need to reset the interface services server port, and then start and stop some 
of the interface services and the Rational DOORS Web Access components to 
pick up the new values:
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• Resetting the interface services server port

• Starting and stopping components

Resetting the interface services server port
You need to reset the port number in the server.xml file in the conf 
subdirectory:

1. Navigate to the file.

2. Open the file.

3. Change the Shutdown and Start port numbers.

4. To change the Shutdown port number, change the port number in the 
following line:
<Server port="8005" shutdown="SHUTDOWN">

5. To change the Start port number, navigate to the following line:
<!-- Define a non-SSL HTTP/1.1 Connector on port 8080 -->

6. Change the port number in the next line:
<Connector port=“8080”

7. Save the file.

Starting and stopping components
You need to start and stop the following components:

• The Rational DOORS Web Access broker

• The Interoperation Server

• The Rational DOORS Web Access server

• The interface services server

Starting and stopping the Rational DOORS Web Access broker

1. Start the Rational DOORS Web Access broker by running 
broker.start.sh. This file is in the directory where you extracted 
festival-sol.zip when you installed the Rational DOORS Web Access.

2. Stop the Rational DOORS Web Access broker by running 
broker.shutdown.sh. This file is in the same directory as 
broker.start.sh.
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Starting and stopping the Interoperation Server

1. Start the Interoperation Server by running it with its command-line 
attributes in the following format:
./doors9 -interop –data port@myserver –brokerHost 
myBroker –brokerPort brokerport &

where:

• port is the port number the Rational DOORS database server is using 
and myserver is the name of the machine where the Rational DOORS 
database server is installed

• myBroker is the name of the machine hosting the broker
• brokerport is the port that the broker is using, by default 61616

2. Stop the Interoperation Server by killing the process

Starting and stopping the Rational DOORS Web Access server

1. Start the Rational DOORS Web Access server by running 
server.start.sh. This file is in the directory where you extracted 
festival-sol.zip when you installed the Rational DOORS Web Access.

2. Stop the Rational DOORS Web Access server by running 
server.shutdown.sh. This file is in the same directory as 
server.start.sh.

Starting and stopping the interface services server

1. Start the interface services server by running server.start.sh. This file is 
in the directory where you extracted festival-sol.zip when you installed 
the interface services.

2. Stop the interface services server by running server.shutdown.sh. This 
file is in the same directory as server.start.sh.

Uninstalling interface services
To remove interface services from your system:
• Uninstall the interface services server and broker by deleting the festival 

directory

• Uninstall the Interoperation Server and the Rational DOORS database 
server by deleting $DOORSHOME
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10 Installing the Rational DOORS server 
interface services on Linux

This chapter contains the following:

• Introduction

• The interface services components

• Installing the Rational DOORS database server

• Installing the Interoperation Server

• Installing the interface services server and broker

• Starting the system

• Shutting down the system

• Running interface services and Rational DOORS Web Access on the same 
machine

• Uninstalling interface services

Introduction
During the installation of the Rational DOORS database server, there is a 
prompt asking you whether you want to install the Rational DOORS server 
interface services. When you enter y, you install both the Rational DOORS 
database server and the Rational DOORS server interface services (interface 
services), which allows Rational DOORS to interface with selected integration 
products.
This chapter describes how install and set up the interface services on Linux.
If you only want to install the Rational DOORS database server, ignore this 
chapter and follow the steps in “Installing the Rational DOORS database 
server”, on page 37. 
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The interface services components
Installing the interface services involves the installation of a number of discrete 
components. These components are copied to your machine.

You must install these components to run the interface services. Follow the 
instruction in the these topics to install the components.

Installing the Rational DOORS database server
To install the Rational DOORS database server:
1. Follow step 1 to step 9 in “Installing the Rational DOORS database server”, 

on page 37.

2. Answer the prompts on the screen:

a. Enter path to DVD-ROM device or Rational DOORS distribution:

Component Description

Interface services server An adaptation of Apache Tomcat. 
Tomcat is an application server that 
executes Java servlets and renders web 
pages that include JavaServer Pages code.
You need to run the adapted version of 
Tomcat that is supplied by Rational as 
one of the Rational DOORS interface 
services bundled components.

Interface services broker An adaptation of Apache ActiveMQ. 
ActiveMQ is an open source message 
broker that implements the Java Message 
Service (JMS) 
The broker is supplied by Rational as one 
of the Rational DOORS interface 
services bundled components.

Rational DOORS database server The data you are accessing is stored in 
your Rational DOORS database server.

Interoperation Server A Rational DOORS client that is run 
using the -interop command-line 
parameter.
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b. Enter y at the second prompt, to install the Rational DOORS database 
server:
Install package DOORS_SERVER [y]: y

c. Enter the path to the Rational DOORS home directory you created in 
Step 6 of “Installing the Rational DOORS database server”, on page 37.

d. Enter y at the prompt:
Install DOORS SERVER Interface Services [n]: y

This copies the festival-linux.zip file, which contains the interface 
services server and broker, to your machine. You extract the file and 
install them later.

e. Enter the name of the Rational DOORS owner (by default, doors).

f. Confirm that you want to install the server.

g. The installation script then confirms all the installation options and 
installs the files. Press ENTER when the installation finishes.

3. Edit the startup file of the Rational DOORS owner.

The following table shows the lines you must add or edit:

4. Start the Rational DOORS database server:

a. Log on as the Rational DOORS owner user.

b. Change your working directory to $DOORSHOME/bin.

c. Enter the following command:

Startup file Code

Bourne or K shell 
.profile 

DOORSHOME=doors-home-path

SERVERDATA=datapath

PATH=$DOORSHOME/bin:$PATH

PORTNUMBER=database-server-port-number

export DOORSHOME SERVERDATA PATH PORTNUMBER 
DOORSDATA

C shell .login setenv DOORSHOME doors-home-path

setenv SERVERDATA datapath

set path=($DOORSHOME/bin $path)

setenv PORTNUMBER database-server-port-number
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./doorsd &

Note  If you use the Korn shell and do not use “doorsd 
&” in a system startup script, execute the following 
command instead:

“nohup doorsd &”

Installing the Interoperation Server
To run the interface services on a Linux system, you must install an 
Interoperation Server.
To install the Interoperation Server:
1. Copy linux.zip to the machine you want to run the Interoperation Server 

on and log on as root.

2. Create a home directory for the installation.

3. Create a non-privileged account to own the Interoperation Server files. You 
could call this user doors.

4. Navigate to the directory containing linux.zip and extract it:
unzip linux.zip

5. Navigate to the directory containing the installers and run the installers:
cd unix/bin

6. Run the installers:
./instdoor.sh

You use this file to install the Interoperation Server.

7. Answer the prompts on the screen:

a. Enter path to CD-ROM device or Rational DOORS distribution.

b. Accept the installation of the Interoperation Server.

c. Enter the path to the Rational DOORS home directory you created in 
Step 2.

d. Enter y to confirm that you want to install the interface services. This 
copies the festival-linux.zip file, which contains the interface 
services server and broker, to your machine. You extract the file and 
install them later.

e. Enter the name of the Rational DOORS owner you set up in Step 3.
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f. Confirm the type of installation. Select both the Common installation 
and the Linux installation.

8. The installation script then confirms all the installation options and installs 
the files.

9. When the installation finishes, press ENTER. Any updates that are required 
for the account profile that you created to own the Interoperation Server 
files are displayed in the output.

Installing the interface services server and broker
To install the interface services server and the interface services broker:
1. Copy the festival-linux.zip, which is in the interfaces directory of 

the server installation area, to the machine or machines you want to install 
interface services server and broker on. If you want to install the server and 
broker on different machines, repeat the following instructions on each 
machine.

2. Decide which directory you want to install on, and extract festival-
linux.zip to install it.

3. Set the appropriate permissions on the files in the directory structure and 
install the JRE by running the configure-festival.sh script.

a. Navigate to the festival directory.

b. Run the script:
bash configure-festival.sh

Note  The script reports that it is installing JRE. JRE is 
localized to the current directory and does not affect any 
other Java installations on the system.

You are now ready to set up the components to communicate with one another. 
For instructions, see “Setting up the components”, on page 44. 

Note  The instructions in the section entitled “Setting up the 
components”, on page 44 are the same for Windows, Solaris, 
and Linux with one exception. When you set up the Rational 
DOORS database server you need to run dbadmin. On 
Solaris and Linux, dbadmin is located in the $DOORSHOME/
bin directory.

If you want to run multiple Interoperation Servers, see “Running multiple 
Interoperation Servers”, on page 48.
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Starting the system
To start the system you must start the processes in the following order:

1. Log on as the user who owns the Rational DOORS files. This is the user you 
created when you installed the Interoperation Server.

2. Start the broker by running broker.start.sh, which is in the festival 
directory on the machine hosting the broker.

3. Set the following environment variables on the machine hosting the Rational 
DOORS database server.
DOORSHOME=doors-home-path
SERVERDATA=path_to_data_directory
PATH=$DOORSHOME/bin:$PATH
PORTNUMBER=database-server-port-number
export DOORSHOME SERVERDATA PATH PORTNUMBER DOORSDATA

Note  This DOORSHOME variable relates to where the 
Rational DOORS database server is installed.

4. Start the Rational DOORS database server:

a. Log on as the user that owns the Rational DOORS files.

b. Change your working directory to $DOORSHOME/bin.

c. Enter the following command:
./doorsd &

5. Set the following environment variables on the machine hosting the 
Interoperation Server:
DOORSHOME=doors-home-path
DOORSDATA=36677@myserver
PATH=$DOORSHOME/bin:$PATH
export DOORSHOME PATH DOORSDATA

Note  If the installation directory for the database server and 
the Interoperation Server are different, the required 
profile updates are in conflict. This DOORSHOME variable 
relates to where the Interoperation Server is installed. 
This might be different from the DOORSHOME variable 
used in Step 3.

d. Navigate to $DOORSHOME/bin and run the Interoperation Server with its 
command-line attributes in the following format:
./doors9 -interop –data port@myserver –brokerHost 
myBroker –brokerPort brokerport &



Rational DOORS Installation Guide           77

Shutting down the system

where: 

• port is the port number the Rational DOORS database server is 
using and myserver is the name of the machine where the Rational 
DOORS database server is installed 

• myBroker is the name of the machine hosting the broker
• brokerport is the port that the broker is using, by default 61616

6. Start the interface services server by running server.start.sh, which is in 
the festival directory on the machine hosting the server.

Shutting down the system
To shut down the system stop the following processes:
1. Stop the interface services server by running server.shutdown.sh script. 

This script is in the festival directory. The process might take some time 
to end (15-30 seconds), and might report a number of socket warnings while 
shutting down. 

2. Stop the Interoperation Server by killing the process.

3. Stop the Rational DOORS database server using the following command 
from $DOORSHOME/bin: 

dbadmin -data port@computer -killserver [-password password]

4. Stop the interface services broker by running the broker.shutdown.sh 
script in the festival directory: The process might take some time to end 
(15-30 seconds), and might report a number of socket warnings while 
shutting down.

Running interface services and Rational DOORS Web Access on the 
same machine

Note  This section assumes you have already installed and 
configured the interface services, the Interoperation Server, 
the Rational DOORS client, the Rational DOORS database 
server, and Rational DOORS Web Access.

There are extra tasks you need to complete if you plan to run the interface 
services and Rational DOORS Wed Access on the same machine.
You need to reset the interface services server port, and then start and stop some 
of the interface services and the Rational DOORS Web Access components to 
pick up the new values:
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• Resetting the interface services server port

• Starting and stopping components

Resetting the interface services server port
You need to reset the port number in the server.xml file in the conf 
subdirectory:

1. Navigate to the file.

2. Open the file.

3. Change the Shutdown and Start port numbers.

4. To change the Shutdown port number, change the port number in the 
following line:
<Server port="8005" shutdown="SHUTDOWN">

5. To change the Start port number, navigate to the following line:
<!-- Define a non-SSL HTTP/1.1 Connector on port 8080 -->

6. Change the port number in the next line:
<Connector port=“8080”

7. Save the file.

Starting and stopping components
You need to start and stop the following components:

• The Rational DOORS Web Access broker

• The Interoperation Server

• The Rational DOORS Web Access server

• The interface services server

Starting and stopping the Rational DOORS Web Access broker

1. Start the Rational DOORS Web Access broker by running 
broker.start.sh. This file is in the directory where you extracted 
festival-linux.zip when you installed the Rational DOORS Web 
Access.

2. Stop the Rational DOORS Web Access broker by running 
broker.shutdown.sh. This file is in the same directory as 
broker.start.sh.
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Uninstalling interface services

Starting and stopping the Interoperation Server

1. Start the Interoperation Server by running it with its command-line 
attributes in the following format:
./doors9 -interop –data port@myserver –brokerHost 
myBroker –brokerPort brokerport &

where:

• port is the port number the Rational DOORS database server is using 
and myserver is the name of the machine where the Rational DOORS 
database server is installed

• myBroker is the name of the machine hosting the broker
• brokerport is the port that the broker is using, by default 61616

2. Stop the Interoperation Server by killing the process

Starting and stopping the Rational DOORS Web Access server

1. Start the Rational DOORS Web Access server by running 
server.start.sh. This file is in the directory where you extracted 
festival-linux.zip when you installed the Rational DOORS Web 
Access.

2. Stop the Rational DOORS Web Access server by running 
server.shutdown.sh. This file is in the same directory as 
server.start.sh.

Starting and stopping the interface services server

1. Start the interface services server by running server.start.sh. This file is 
in the directory where you extracted festival-linux.zip when you 
installed the interface services.

2. Stop the interface services server by running server.shutdown.sh. This 
file is in the same directory as server.start.sh.

Uninstalling interface services
To remove interface services from your system:
• Uninstall the interface services server and broker by deleting the festival 

directory

• Uninstall the Interoperation Server and the Rational DOORS database 
server by deleting $DOORSHOME
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11 Installing Rational DOORS for HP Quality 
Center Interface

This chapter contains information about how to install and configure version 3.4 
of Rational DOORS for HP Quality Center Interface to integrate with Rational 
DOORS 9.2. It contains the following:

• Understanding the installation options

• Upgrading from previous versions of the integration

• Installing the Integration Server

• Installing an Integration Client

• Installing the Administration Console

• Upgrading version 3.1 data

• Uninstalling the Integration

Understanding the installation options
The Integration installer has two installation options:

• Integration Client

You install an integration client on each Rational DOORS client that needs 
to use the integration. This option allows the Rational DOORS user to 
access the integration options available in the Rational DOORS client.

• Integration Server

This option installs both the Integration Server and the Integration Client.

Upgrading from previous versions of the integration
The following sections describe what you must do to upgrade to version 3.4 
from a previous version.

• Upgrade from version 1.8

• Upgrade from version 3.0

• Upgrade from version 3.1

• Upgrade from version 3.2 and 3.3
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Upgrade from version 1.8

1. Migrate your data.

You must synchronize your data before you uninstall version 1.8.

2. Uninstall version 1.8 using Add or Remove Programs from the Windows 
Control Panel.

3. Install version 3.1.

You do not have to configure or run version 3.1 after you install it, but you 
must install it before you install version 3.4.

4. Install version 3.4 and migrate 3.1 data to 3.4.

For information about migrating data from version 3.1 to 3.4, see 
“Upgrading version 3.1 data,” on page 88.

Upgrade from version 3.0
On machines with version 3.0 of TestDirector Integration installed, install 
version 3.1, then install version 3.4 and migrate 3.1 data to 3.4.
For information about migrating data from version 3.1 to 3.4, see “Upgrading 
version 3.1 data,” on page 88.

Upgrade from version 3.1
You can upgrade direct to version 3.4 form version 3.1.
On machines with version 3.1 of TestDirector Integration installed, install 
version 3.4, then migrate 3.1 data to 3.4.
For information about migrating data from version 3.1 to 3.4, see “Upgrading 
version 3.1 data,” on page 88.

Upgrade from version 3.2 and 3.3

Rational DOORS for HP Quality Center Interface includes a migration tool that 
allows you to upgrade and migrate from version 3.2 and 3.3.

Installing the Integration Server
If you are upgrading the Integration Server, see “Upgrading from previous 
versions of the integration,” on page 81 for information about how to upgrade 
to 3.4.
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Installing the Integration Server

Run the installer

To install the Integration Server:
1. Check that you meet the system requirements. Details of system 

requirements can be found in the Rational DOORS for HP Quality Center 
Interface readme file, which is available from our Web site at http://
publib.boulder.ibm.com/infocenter/rsdp/v1r0m0/index.jsp.

2. If you are running version 3.2 or 3.3, uninstall it.

3. Make sure that you are logged on to your computer as a user with 
Administrator privileges.

4. Shut down all other applications. In particular, shut down Microsoft Office 
applications, including the Microsoft Office toolbar.

5. Check that the default Web site in the Internet Services Manager is started. 
If it is not, right-click and select Start.

6. Using Windows Explorer, double-click setup.exe.

The Welcome screen is displayed.

If the Modify/Repair/Remove dialog box is displayed, exit the installer 
and modify the installation using Add or Remove Programs in the 
Windows Control Panel.

Note  If the .NET Framework v2.0 is not detected by the 
installer, a browser window is opened at Microsoft’s 
.NET Framework download page. You must install the 
.NET Framework before you continue. You might need 
to reboot your machine.

7. Click Next.
The License Agreement screen is displayed.

8. Select the I accept option and click Next.
The Choose Destination Location screen is displayed.

9. Enter the path to the folder you want to install to, or leave the default.

10. Click Next.
The Setup Type screen is displayed.

11. Select Server and click Next.
Note  This option installs both the Integration Client and the 

Integration Server.
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The Integration Server TCP Port screen is displayed.

12. Enter the TCP port on which the Internet Information Service is serving 
the default Web site.

To find out the port number:

a. On the desktop, right-click on My Computer and select Manage.

The Computer Management window is displayed.

b. Navigate Services and Applications > Internet Information Service 
(IIS) Manager > Web Sites.

c. Right-click Default Web Site and select Properties.

The TCP Port is displayed in the Web Site Identification panel.

13. Click Next.
The Enter Domain\Groupname screen is displayed.

14. Enter the fully qualified group name that is authorized to access the 
Administration Console. Domain is the name of the machine you are 
installing the Integration Server on and Groupname is the name of a group 
with the necessary privileges (for example, 
QCI_Server\QCI_Admin_Console_Users).

If you need to create the group, use the Computer Management window.

15. Click Next.
The Ready to Install the Program screen is displayed.

16. Click Install.
The necessary files are installed on the machine.

Note  If you do not have IIS installed, an error is displayed. 
You must click Abort, install IIS, then reinstall the 
Integration Server.

17. Click Finish.

The install wizard closes.

Run the configuration tool

Before you proceed, you need to configure the Integration Server.
To configure the Integration Server:
1. If it is still open, shut down the Computer Manager.
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Installing the Integration Server

2. From the Start menu select IBM Rational > IBM Rational Lifecycle 
Solution Tools > IBM Rational DOORS Quality Center Integration 
3.4 Tools > Set Access Permissions.

The Rational DOORS for HP Quality Center Interface Configuration 
Tool dialog box is displayed.

3. In Username enter a user.

By default, a local machine user called IWSUSER is used in this tool. 
However, you can specify a domain user instead. The tool cannot create a 
domain user, but if one exists it can be used.

• If you want to specify or create IWSUSER, enter 
<machinename>\IWSUSER.
• If a user named IWSUSER already exists, leave the check box clear.
• If a user named IWSUSER does not exist, select the check box.

• If you want to specify a domain user, enter <domainname>\<user 
name>, and leave the check box clear.

4. Enter a password in the Password and Confirm Password boxes.

• If IWSUSER exists, enter the user’s existing password.
• If IWSUSER does not exist, enter a new password.

This password uses the Windows 2003 password rules that are in force 
on your system.

5. Click Next.
The Gathering the virtual folder structure dialog box is displayed.

6. Enter the name of the Web site that is hosting the services, or leave the 
default.

7. Enter the path to the location of the virtual folder for Tivoli Directory 
Integrator Services and the SOQ Services, or leave the defaults.

8. Click Next.
The Applying configuration dialog box is displayed.

A warning dialog box is also displayed.

9. Click Yes. When all the categories have been successfully configured, click 
Next. 
A summary screen is displayed.

You can use the Copy button to copy the summary text.

10. Click Next.
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The Testing Services dialog box is displayed.

You can use the Copy button to copy the results text.

11. Select Run Tests to test the availability of the services.

12. If necessary, add the IWSUSER to the group you created in step 14 of “Run 
the installer,” on page 83.

13. Navigate to Quality Center and log on to download ActiveX components.

14. Click Finish.

Installing an Integration Client
Once the Integration Server has been installed, you can install the Integration 
Client on the Rational DOORS and Quality Center client machines that you 
want to access the integration.
To install the Integration Client:
1. Check that you meet the system requirements. Details of system 

requirements can be found in the Rational DOORS for HP Quality Center 
Interface readme file, which is available from our Web site at http://
publib.boulder.ibm.com/infocenter/rsdp/v1r0m0/index.jsp.

2. Make sure that you are logged on to your computer as a user with 
Administrator privileges.

3. Shut down all other applications. In particular, shut down Microsoft Office 
applications.

4. Using Windows Explorer, double-click setup.exe.

The Welcome screen is displayed.

If the Modify/Repair/Remove dialog box is displayed, exit the installer 
and modify the installation using Add or Remove Programs in the 
Windows Control Panel.

5. Click Next.
The License Agreement screen is displayed.

6. Select the I accept option and click Next.
The Choose Destination Location screen is displayed.

7. Enter the path to the folder you want to install to, or leave the default and 
click Next.
The Setup Type screen is displayed.
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Installing the Administration Console

8. Select Client and click Next.
The Specify the Location of Integration Server screen is displayed.

9. In IP address, enter the fully qualified domain name or IP address of the 
machine on which the Integration Server is installed.

10. In TCP Port, enter the TCP Port on which the Integration Administration 
Service is serving the Default Web site on the Integration Server machine. 
This TCP Port was entered in Step 12 of Installing the Integration Server.

11. Click Next.
The Ready to Install the Program screen is displayed.

12. Click Install.
A progress bar is displayed as the files are installed.

13. Click Finish.

Installing the Administration Console
To install the Administration Console:
1. Make sure that you have both the .NET Framework v2.0 and v3.0 installed.

2. Open your Internet browser and type http://<integrationserver>/
AdminToolInstall.

The Administration Console installation welcome page is displayed.

3. If you need to install the .NET Framework, do so now.

Note  The .NET Framework is installed in the background. 
Make sure that it is installed before you proceed. The 
.NET icon is displayed in the notification area on the 
taskbar.

4. Run the Administration Console installer.

Click setup.

5. If you want to install the Administration Console from the local machine, 
select Save, then double-click the setup.exe file. If you want to install the 
Administration Console from the network, select Run.

The Welcome screen is displayed.

6. Click Next.
The License Agreement screen is displayed.
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7. Accept the terms of the agreement and click Yes.

The Choose Destination Location screen is displayed.

8. Enter the path to the folder you want to install to, or leave the default and 
click Next.
The Ready to Install the Program screen is displayed.

9. Click Install.
A progress bar is displayed as the files are installed.

10. Click Finish.

11. Start the Administration Console.

From the Start menu select IBM Rational > IBM Rational Lifecycle 
Solution Tools > IBM Rational DOORS Quality Center Integration 
3.4 Tools > Administration Tool.

Upgrading version 3.1 data
To upgrade version 3.1 data to version 3.4:
1. Shut down Web Services.

2. Run the Migration tool.

From the Start menu select IBM Rational > IBM Rational Lifecycle 
Solution Tools > IBM Rational DOORS Quality Center Integration 
3.4 Tools > Migrate 3.1 Data to 3.4.

3. Select the 3.1 folder

Enter the location of the 3.1 data. By default this data is in 
c:\inetpub\wwwroot\doorstdintegrationwebservices.

4. Select the 3.4 folder.

Enter the location of the 3.4 data. By default this data is in 
c:\inetpub\wwwroot\DOORSTDIServices\.

5. Click Perform Migration.

The migration is performed.

6. Restart Web Services to pick up the migrated data.
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Uninstalling the Integration

Uninstalling the Integration
Use Add or Remove Programs in the Windows Control Panel to remove 
version 3.4 of Rational DOORS for HP Quality Center Interface and the 
Administration Console.
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12 Installing Rational DOORS for ClearCase 
Interface on Windows

This chapter describes how to install and set up version 2.1.1 of Rational 
DOORS for ClearCase Interface to integrate with Rational DOORS 9.2. It 
contains the following:

• Installing Rational DOORS for ClearCase Interface

• Uninstalling Rational DOORS for ClearCase Interface

Installing Rational DOORS for ClearCase Interface
Follow these steps to install Rational DOORS for ClearCase Interface:
1. Check that you meet the system requirements. Details of system 

requirements can be found in the Rational DOORS for ClearCase Interface 
readme file, which is available from our Web site at http://
publib.boulder.ibm.com/infocenter/rsdp/v1r0m0/index.jsp.

2. Make sure that you are logged on to your computer as the local 
Administrator, and not a user with Administrator privileges.

3. Shut down all other applications. In particular, shut down Rational DOORS 
and ClearCase.

4. You can either install from the Rational DOORS Add Ons CD or from 
software downloaded from the Rational Web site.

If you are installing from CD, put the Rational DOORS Add Ons CD into 
your CD-ROM drive, browse to the Rational DOORS for ClearCase 
Interface software and click to install. The installer runs, and the Welcome 
screen is displayed.

If you downloaded the software from the Web site, navigate to the file you 
downloaded, and double-click it. The installer runs, and the Welcome 
screen is displayed.

5. Run the installation, following the instructions on screen.

6. When the installation is complete, the setup complete screen is displayed.

7. Click Finish to complete setup.
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For information about how the integration works, see the Using Rational DOORS 
for ClearCase Interface manual, which is available from our Web site at 
www.ibm.com/software/awdtools/doors/support/doc.html.

Uninstalling Rational DOORS for ClearCase Interface
Use Add or Remove Programs in the Windows Control Panel to remove 
version 2.1.1 of Rational DOORS for ClearCase Interface.
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13 Installing Rational DOORS for ClearQuest 
Interface on Windows

This chapter describes how to install and set up version 2.2.1 of Rational 
DOORS for ClearQuest Interface to integrate with Rational DOORS 9.2. It 
contains the following:

• Installing Rational DOORS for ClearQuest Interface

• Uninstalling Rational DOORS for ClearQuest Interface

Installing Rational DOORS for ClearQuest Interface
Follow these steps to install Rational DOORS for ClearQuest Interface:

1. Check that you meet the system requirements. Details of system 
requirements can be found in the Rational DOORS for ClearQuest 
Interface readme file, which is available from our Web site at http://
publib.boulder.ibm.com/infocenter/rsdp/v1r0m0/index.jsp.

2. Make sure that you are logged on to your computer as the local 
Administrator, and not a user with Administrator privileges.

3. Shut down all other applications. In particular, shut down Rational DOORS 
and ClearQuest.

4. You can either install from the Rational DOORS Add Ons CD or from 
software downloaded from the Rational Web site.

If you are installing from CD, put the Rational DOORS Add Ons CD into 
your CD-ROM drive, browse to the Rational DOORS for ClearQuest 
Interface software and click to install. The installer runs, and the Welcome 
screen is displayed.

If you downloaded the software from the Web site, navigate to the file you 
downloaded, and double-click it. The installer runs, and the Welcome 
screen is displayed.

5. Run the installation, following the instructions on screen.

6. When the installation is complete, the setup complete screen is displayed.

7. Click Finish to complete setup.
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For information about how the integration works, see the Using Rational DOORS 
for ClearQuest Interface manual, which is available from our Web site at 
www.ibm.com/software/awdtools/doors/support/doc.html.

Uninstalling Rational DOORS for ClearQuest Interface
Use Add or Remove Programs in the Windows Control Panel to uninstall 
version 2.2.1 of Rational DOORS for ClearQuest Interface.
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14 Installing Rational DOORS for Rational Rose 
Interface on Windows

This chapter describes how to install and set up version 2.10.1 of Rational 
DOORS for Rational Rose Interface to integrate with Rational DOORS 9.2. It 
contains the following:

• Installing Rational DOORS for Rational Rose Interface

• Uninstalling Rational DOORS for Rational Rose Interface

Installing Rational DOORS for Rational Rose Interface
Follow these steps to install Rational DOORS for Rational Rose Interface:
1. Check that you meet the system requirements. Details of system 

requirements can be found in the Rational DOORS for Rational Rose 
Interface readme file, which is available from our Web site at http://
publib.boulder.ibm.com/infocenter/rsdp/v1r0m0/index.jsp.

2. Make sure that you are logged on to your computer as the local 
Administrator, and not a user with Administrator privileges.

3. Shut down all other applications. In particular, shut down Rational DOORS 
and Rational Rose.

4. You can either install from the Rational DOORS Add Ons CD or from 
software downloaded from the Rational Web site.

If you are installing from CD, put the Rational DOORS Add Ons CD into 
your CD-ROM drive, browse to the Rational DOORS for Rational Rose 
Interface software and click to install. The installer runs, and the Welcome 
screen is displayed.

If you downloaded the software from the Web site, navigate to the file you 
downloaded, and double-click it. The installer runs, and the Welcome 
screen is displayed.

5. Run the installation, following the instructions on screen.

6. When the installation is complete, the setup complete screen is displayed.

7. Click Finish to complete setup.
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For information about how the integration works, see the Using Rational DOORS 
for Rational Rose Interface manual, which is available from our Web site at 
www.ibm.com/software/awdtools/doors/support/doc.html.

Uninstalling Rational DOORS for Rational Rose Interface
Use Add or Remove Programs in the Windows Control Panel to remove 
version 2.10.1 of Rational DOORS for Rational Rose Interface.
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15 Installing Rational DOORS for Serena PVCS 
Version Manager Interface on Windows

This chapter describes how to install and set up version 1.4.1 of Rational 
DOORS for Serena PVCS Version Manager Interface to integrate with Rational 
DOORS 9.2. It contains the following topics:

• Installing Rational DOORS for Serena PVCS Version Manager Interface

• Setting up licences

• Uninstalling Rational DOORS for Serena PVCS Version Manager Interface

Installing Rational DOORS for Serena PVCS Version Manager 
Interface

Follow these steps to install Rational DOORS for Serena PVCS Version 
Manager Interface:
1. Check that you meet the system requirements. Details of system 

requirements can be found in the Rational DOORS for Serena PVCS 
Version Manager Interface readme file, which is available from our Web site 
at http://publib.boulder.ibm.com/infocenter/rsdp/v1r0m0/index.jsp.

2. Make sure that you are logged on to your computer as the local 
Administrator, and not a user with Administrator privileges.

3. Shut down all other applications. In particular, shut down Rational DOORS 
and Serena PVCS Version Manager.

4. You can either install from the Rational DOORS for Serena PVCS Version 
Manager Interface CD or from software downloaded from the Rational Web 
site.

If you are installing from CD, put the Rational DOORS for Serena PVCS 
Version Manager Interface CD into your CD-ROM drive, browse to the 
Rational DOORS for Serena PVCS Version Manager Interface software and 
click to install. The installer runs, and the Welcome screen is displayed.

If you downloaded the software from the Web site, navigate to the file you 
downloaded, and double-click it. The installer runs, and the Welcome 
screen is displayed.

5. Run the installation, following the instructions on screen.
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6. When the installation is complete, the setup complete screen is displayed.

7. Click Finish to complete setup.

For information about how the integration works, see the Using Rational DOORS 
for Serena PVCS Version Manager Interface manual, which is available from our Web 
site at www.ibm.com/software/awdtools/doors/support/doc.html.

Setting up licences
If you are installing Rational DOORS for Serena PVCS Version Manager 
Interface for the first time or reinstalling or upgrading from an earlier version of 
the integration, you have to request and setup a new license before you can use it. 
For information about licensing, see the Rational License Server TL Licensing Guide, 
which is available from the Rational Lifecycle Solutions DVD, and from our 
Web site at http://publib.boulder.ibm.com/infocenter/rsdp/v1r0m0/index.jsp.

Uninstalling Rational DOORS for Serena PVCS Version Manager 
Interface

Use Add or Remove Programs in the Windows Control Panel to remove 
version 1.4.1 of Rational DOORS for Serena PVCS Version Manager Interface.
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16 Troubleshooting
This chapter contains the following:

• Installing Rational DOORS as a non-admin user

• Problems installing the software

• If you have no Export to Rational DOORS icon in Word

• Using the Rational DOORS API

• Colors

• DISPLAY variables on Solaris

• DISPLAY variables—all UNIX installations

• Dual Boot Machines

Note  Go to the support center on our Web site at www.ibm.com/
software/awdtools/doors/support/doc.html for the latest 
information about problems you might encounter when you 
install and set up Rational DOORS, and how to work around 
the problems.

Installing Rational DOORS as a non-admin user
When you install the Rational DOORS database server, you must be logged on 
to the machine as a user with administrator privileges. However, you can install 
the Rational DOORS client as a non-admin user providing the system 
administrator has set up the non-admin user with the following options.

• On Windows 2003 systems the user that launches the installation must have 
been granted the impersonate privilege:

a. Click Start > All Programs > Administrative Tools > Local Security 
Policy.

b. Expand Local Policies, and then click User Rights Assignment.
c. In the right pane, double-click Impersonate a client after 

authentication.

d. In the Local Security Policy Setting dialog box, click Add.

e. In the Select Users or Group dialog box, click the user account that 
you want to add, click Add, and then click OK.
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f. Click OK.

• The Always install with elevated privileges policy must be enabled in the 
group policy for non-admin users who need to install the Rational DOORS 
client.

• If you are upgrading from a previous version, you must remove it using Add 
or Remove Programs in the Windows Control Panel before you install 
Rational DOORS 9.2.

Problems installing the software
If you have problems installing any of the products in the Rational DOORS 
product family, try these solutions before you contact our Support team for help:

• Stop all applications before you install the software.

Shut down all the applications running on your computer.

• Turn off virus protection software.

When virus protection software is running in the background, it can 
interfere with the installation of any software product because of the way 
installers extract files when they install them on your computer.

• Make sure that you meet the system requirements for the product you are 
trying to install. Details of system requirements can be found in the 
appropriate readme file. The product readme files are available from our 
Web site at http://publib.boulder.ibm.com/infocenter/rsdp/v1r0m0/
index.jsp.

• Restart your computer, and then try installing the Rational DOORS product 
again.

If you have no Export to Rational DOORS icon in Word
If you have no Export to Rational DOORS button, it might be because you have 
modified the location of your Word startup folder.
You can change or check this folder by clicking Tools > Options. On the File 
Locations tab, the Startup entry shows the location of your Word startup folder.
In this case, copy doors.dot from the \lib\word folder in the Rational 
DOORS home folder (for example, c:\program 
files\IBM\Rational\doors\9.2\lib\word) to your Word startup folder.
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Using the Rational DOORS API

Using the Rational DOORS API
The Rational DOORS API only works with TCP/IP communication. Socket-
based communication in UNIX is not supported.

Colors
Display cards that support only 256 colors might result in unusual color effects.

DISPLAY variables on Solaris
A Solaris Rational DOORS client can now run in batch mode without a 
DISPLAY environment variable being set.
If the batch-mode DXL attempts to use the GUI and DISPLAY has not been 
defined, Rational DOORS exits.
If DISPLAY has been defined, Rational DOORS attempts to connect to the 
specified X display, even if the batch-mode DXL does not use a GUI. As a result, 
DISPLAY must refer to a valid X display that you are authorized to connect to.

DISPLAY variables—all UNIX installations
The X display must be specified with the DISPLAY environment variable; using 
the standard -display or -d options does not work.

Dual Boot Machines
If you have a dual boot machine and Rational DOORS 9.2 is installed on one of 
the operating systems you cannot install it on the other operating system as well.



Troubleshooting

102    Rational DOORS Installation Guide



Rational DOORS Installation Guide     103

17 Contacting support
This chapter contains the following topics:

• Contacting IBM Rational Software Support

• Prerequisites

• Submitting problems

• Other information

Contacting IBM Rational Software Support
If the self-help resources have not provided a resolution to your problem, you 
can contact IBM Rational Software Support for assistance in resolving product 
issues.

Note  If you are a heritage Telelogic customer, you can go to 
http://support.telelogic.com/toolbar and download the 
IBM Rational Telelogic Software Support browser toolbar. 
This toolbar helps simplify the transition to the IBM Rational 
Telelogic product online resources. Also, a single reference 
site for all IBM Rational Telelogic support resources is 
located at 
http://www.ibm.com/software/rational/support/telelogic/

Prerequisites
To submit your problem to IBM Rational Software Support, you must have an 
active Passport Advantage® software maintenance agreement. Passport 
Advantage is the IBM comprehensive software licensing and software 
maintenance (product upgrades and technical support) offering. You can enroll 
online in Passport Advantage from 
http://www.ibm.com/software/lotus/passportadvantage/howtoenroll.html.

• To learn more about Passport Advantage, visit the Passport Advantage 
FAQs at 
http://www.ibm.com/software/lotus/passportadvantage/brochures_faqs_
quickguides.html.

• For further assistance, contact your IBM representative.

To submit your problem online (from the IBM Web site) to IBM Rational 
Software Support, you must additionally:
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• Be a registered user on the IBM Rational Software Support Web site. For 
details about registering, go to 
http://www-01.ibm.com/software/support/.

• Be listed as an authorized caller in the service request tool.

Submitting problems
To submit your problem to IBM Rational Software Support:

1. Determine the business impact of your problem. When you report a 
problem to IBM, you are asked to supply a severity level. Therefore, you 
need to understand and assess the business impact of the problem that you 
are reporting.

Use the following table to determine the severity level.

2. Describe your problem and gather background information, When 
describing a problem to IBM, be as specific as possible. Include all relevant 
background information so that IBM Rational Software Support specialists 
can help you solve the problem efficiently. To save time, know the answers 
to these questions:

• What software versions were you running when the problem occurred?

To determine the exact product name and version, use the option 
applicable to you: 

Severity Description

1 The problem has a critical business impact: You are unable to 
use the program, resulting in a critical impact on operations. 
This condition requires an immediate solution.

2 This problem has a significant business impact: The program 
is usable, but it is severely limited.

3 The problem has some business impact: The program is 
usable, but less significant features (not critical to 
operations) are unavailable.

 4 The problem has minimal business impact: The problem 
causes little impact on operations or a reasonable 
circumvention to the problem was implemented.
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Submitting problems

• Start the IBM Installation Manager and select File > View 
Installed Packages. Expand a package group and select a package 
to see the package name and version number. 

• Start your product, and click Help > About to see the offering 
name and version number. 

• What is your operating system and version number (including any 
service packs or patches)? 

• Do you have logs, traces, and messages that are related to the problem 
symptoms? 

• Can you recreate the problem? If so, what steps do you perform to 
recreate the problem? 

• Did you make any changes to the system? For example, did you make 
changes to the hardware, operating system, networking software, or 
other system components? 

• Are you currently using a workaround for the problem? If so, be 
prepared to describe the workaround when you report the problem.

3. Submit your problem to IBM Rational Software Support. You can submit 
your problem to IBM Rational Software Support in the following ways:

• Online: Go to the IBM Rational Software Support Web site at 
https://www.ibm.com/software/rational/support/ and in the Rational 
support task navigator, click Open Service Request. Select the 
electronic problem reporting tool, and open a Problem Management 
Record (PMR), describing the problem accurately in your own words.

For more information about opening a service request, go to 
http://www.ibm.com/software/support/help.html

You can also open an online service request using the IBM Support 
Assistant. For more information, go to 
http://www-01.ibm.com/software/support/isa/faq.html.

• By phone: For the phone number to call in your country or region, go 
to the IBM directory of worldwide contacts at 
http://www.ibm.com/planetwide/ and click the name of your country 
or geographic region. 

• Through your IBM Representative: If you cannot access IBM 
Rational Software Support online or by phone, contact your IBM 
Representative. If necessary, your IBM Representative can open a 
service request for you. You can find complete contact information for 
each country at http://www.ibm.com/planetwide/.
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If the problem you submit is for a software defect or for missing or inaccurate 
documentation, IBM Rational Software Support creates an Authorized Program 
Analysis Report (APAR). The APAR describes the problem in detail. Whenever 
possible, IBM Rational Software Support provides a workaround that you can 
implement until the APAR is resolved and a fix is delivered. IBM publishes 
resolved APARs on the IBM Rational Software Support Web site daily, so that 
other users who experience the same problem can benefit from the same 
resolution.

Other information
For Rational software product news, events, and other information, visit the 
IBM Rational Software Web site on http://www.ibm.com/software/rational/.
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18 Notices
© Copyright IBM Corporation 1993, 2009
US Government Users Restricted Rights - Use, duplication, or disclosure 
restricted by GSA ADP Schedule Contract with IBM Corp.
This information was developed for products and services offered in the U.S.A. 
IBM may not offer the products, services, or features discussed in this document 
in other countries. Consult your local IBM representative for information on the 
products and services currently available in your area. Any reference to an IBM 
product, program, or service is not intended to state or imply that only that IBM 
product, program, or service may be used. Any functionally equivalent product, 
program, or service that does not infringe any IBM intellectual property right 
may be used instead. However, it is the user’s responsibility to evaluate and verify 
the operation of any non-IBM product, program, or service. 
IBM may have patents or pending patent applications covering subject matter 
described in this document. The furnishing of this document does not grant you 
any license to these patents. You can send written license inquiries to:  
 
IBM Director of Licensing 
IBM Corporation 
North Castle Drive 
Armonk, NY 10504-1785 
U.S.A.  
 
For license inquiries regarding double-byte character set (DBCS) information, 
contact the IBM Intellectual Property Department in your country or send 
written inquiries to:  
 
IBM World Trade Asia Corporation 
Licensing 
2-31 Roppongi 3-chome, Minato-ku 
Tokyo 106-0032, Japan  
 
The following paragraph does not apply to the United Kingdom or any 
other country where such provisions are inconsistent with local law: 
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES 
THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, 
EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, 
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THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. 
Some states do not allow disclaimer of express or implied warranties in certain 
transactions. Therefore, this statement may not apply to you. 
This information could include technical inaccuracies or typographical errors. 
Changes are periodically made to the information herein; these changes will be 
incorporated in new editions of the publication. IBM may make improvements 
and/or changes in the product(s) and/or the program(s) described in this 
publication at any time without notice. 
Any references in this information to non-IBM Web sites are provided for 
convenience only and do not in any manner serve as an endorsement of those 
Web sites. The materials at those Web sites are not part of the materials for this 
IBM product and use of those Web sites is at your own risk. 
IBM may use or distribute any of the information you supply in any way it 
believes appropriate without incurring any obligation to you. 
Licensees of this program who wish to have information about it for the 
purpose of enabling: (i) the exchange of information between independently 
created programs and other programs (including this one) and (ii) the mutual use 
of the information which has been exchanged, should contact:  
 
Intellectual Property Dept. for Rational Software 
IBM Corporation 
1 Rogers Street 
Cambridge, Massachusetts 02142 
U.S.A. 
 
Such information may be available, subject to appropriate terms and conditions, 
including in some cases, payment of a fee. 
The licensed program described in this document and all licensed material 
available for it are provided by IBM under terms of the IBM Customer 
Agreement, IBM International Program License Agreement or any equivalent 
agreement between us. 
Any performance data contained herein was determined in a controlled 
environment. Therefore, the results obtained in other operating environments 
may vary significantly. Some measurements may have been made on 
development-level systems and there is no guarantee that these measurements 
will be the same on generally available systems. Furthermore, some 
measurements may have been estimated through extrapolation. Actual results 
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Trademarks

may vary. Users of this document should verify the applicable data for their 
specific environment. 
Information concerning non-IBM products was obtained from the suppliers of 
those products, their published announcements or other publicly available 
sources. IBM has not tested those products and cannot confirm the accuracy of 
performance, compatibility or any other claims related to non-IBM products. 
Questions on the capabilities of non-IBM products should be addressed to the 
suppliers of those products.
This information contains examples of data and reports used in daily business 
operations. To illustrate them as completely as possible, the examples include the 
names of individuals, companies, brands, and products. All of these names are 
fictitious and any similarity to the names and addresses used by an actual 
business enterprise is entirely coincidental. 
If you are viewing this information softcopy, the photographs and color 
illustrations may not appear. 
Additional legal notices are described in the legal_information.html file that is 
included in your software installation.

Trademarks

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of 
International Business Machines Corp., registered in many jurisdictions 
worldwide. Other product and service names might be trademarks of IBM or 
other companies. A current list of IBM trademarks is available on the Web at 
www.ibm.com/legal/copytrade.html.
Java and all Java-based trademarks and logos are trademarks of Sun 
Microsystems, Inc. in the United States, other countries, or both.
Linux is a registered trademark of Linus Torvalds in the United States, other 
countries, or both.
Microsoft and Windows are trademarks of Microsoft Corporation in the United 
States, other countries, or both.
UNIX is a registered trademark of The Open Group in the United States and 
other countries.
Other company, product or service names may be trademarks or service marks 
of others.
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